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Trademarks

ClickMail® is a registered trademark of Gracion Software.
Apple, the Apple logo, AppleShare, Macintosh, the Mac OS
logo, and Power Macintosh are trademarks of Apple
Computer, Inc., registered in the U.S.A. and other countries.
All other brands or product names shown are trademarks or
registered trademarks of their respective holders.

Thank you for choosing ClickMail!
ClickMail Central Directory is the perfect complement to
AppleShare IP mail services or any other POP or IMAP mail
server. ClickMail provides the missing link: a master address
book of your users’ email addresses.

Your users on Macintosh, Windows, or Unix (and optionally
the public), can look up email or postal addresses, phone and
fax numbers, any kind of information you want to keep about
people, devices, and services. Thanks to the Internet standard
LDAP protocol, users can find addresses from ClickMail right
from their email programs. LDAP-aware clients include
Netscape Communicator, Outlook Express, Eudora Pro,
Mulberry, QuickMail Pro, Sherlock 2, and Mac OS 9’s
Network Browser.

ClickMail comes in two versions: Basic, with up to 100
entries; and XL, with unlimited entries and remote web
administration.

ClickMail may be evaluated for 30 days from installation.
After the evaluation period, you may purchase ClickMail or
export your data and delete the software.



33

Contents
How ClickMail works ....................................................................... 5
System requirements ...................................................................... 6

Getting started...................................................................................... 7
Installing ClickMail .......................................................................... 7
Files installed in the ClickMail folder ............................................... 7
Other ClickMail files ........................................................................ 8
Test drive ClickMail ......................................................................... 9
Opening the example directory ....................................................... 9
Looking at the entries ................................................................... 10
Looking up with a client program ...................................................11

Setting up a directory ........................................................................ 16
Your data ....................................................................................... 16
Making a new directory ................................................................. 16
Special entries .............................................................................. 19
Importing entries ........................................................................... 20
Typing new entries into ClickMail .................................................. 22

Working with entries .......................................................................... 24
Browsing entries ........................................................................... 24
Finding entries .............................................................................. 24
Editing an entry ............................................................................. 25
Adding an entry ............................................................................. 26
Deleting an entry ........................................................................... 26
Distinguished name in the entry window ...................................... 27

Understanding ClickMail and directories ........................................ 28
Launching ClickMail ...................................................................... 28
Mirroring AppleShare .................................................................... 28
What is an entry? .......................................................................... 30
Distinguished Names—the unique identifiers for entries .............. 30
Basic email lookup directory ......................................................... 32
Tree directory ................................................................................ 33
Formal X.500-style directory ......................................................... 34
Other kinds of entries .................................................................... 35
User strategy: an example ............................................................ 35
LDAP Write ................................................................................... 36

Client programs.................................................................................. 37
Generic directions ......................................................................... 37
Eudora Pro 4 ................................................................................. 37
Mulberry ........................................................................................ 39
Netscape Communicator 4.5 ........................................................ 41
Outlook Express ........................................................................... 43
QuickMail Pro................................................................................ 46
Sherlock 2 and Network Browser ................................................. 48

Export/Import ...................................................................................... 49
Tab-delimited format ..................................................................... 49



4

Contents

LDIF .............................................................................................. 50
vCard ............................................................................................ 50
Import/Data Utility ......................................................................... 50
Importing with Drag-and-drop or AppleScript ................................ 52
Modifying your directory data offline ............................................. 53

Permissions and security ................................................................. 56
Database permissions .................................................................. 56
Attribute permissions .................................................................... 56
Attributes window .......................................................................... 57
Permissions window ..................................................................... 57

Remote Web Administration ............................................................. 61
Installing Web Administration ........................................................ 61
Personal Web Sharing and permissions ....................................... 62
Using Web Administration ............................................................. 65
Edit Mode ...................................................................................... 69
Find Mode ..................................................................................... 71
Browse Mode ................................................................................ 73
Permissions .................................................................................. 74
Customization ............................................................................... 76

Reference ............................................................................................ 77
Menus ........................................................................................... 77
Windows ....................................................................................... 80

Troubleshooting ................................................................................. 88
Error messages in client programs ............................................... 88
Other problems in client programs ................................................ 89
Error messages in ClickMail ......................................................... 91
Web Administration error messages ............................................. 92
Other Web Administration problems ............................................. 92
Other issues .................................................................................. 93

Links and thanks ................................................................................ 95
Web sites ...................................................................................... 95
Colophon ...................................................................................... 95
Acknowledgments! ........................................................................ 96

Glossary .............................................................................................. 97



5

How ClickMail works

ClickMail
Central

Directory LDAP

on
ec
lic
k.c

om

on
ecl

ick
.co

m

onecli
ck.co

m
andy@
oneclick.com

Eudora

Netscape

Outlook

Sherlock

Optional

®

How ClickMail works

The basic purpose of ClickMail Central Directory is to provide
a master address book that a group of people can use to look
up email addresses. When a user wants to send someone
email, he/she opens an email program, types in part of a
name, and clicks Find. The email program asks ClickMail for
the email addresses of everyone who’s name contains “Fred”
(what the user typed). ClickMail sends back a list of people
who match, including name, email, and possibly other
attributes such as phone, pager, address, etc. The user selects
a name and clicks a button to create an addressed message. If
you don’t want to access a server every time you need an
email address, the email program stores captured addresses
in a local address book.

ClickMail is compatible with many email programs because it
uses an Internet protocol, LDAP (Lightweight Directory
Access Protocol). It works with LDAP v2 clients and LDAP v3
clients (not all features of v3 are implemented).

Per LDAP, ClickMail keeps a directory containing entries
for the people listed. Each entry contains attributes that
describe the person, such as common name, email address,
telephone, etc. LDAP clients can search using one or more
attributes (“Give me all Joneses in the Cleveland office that
have fax numbers”). Or they can just download all the entries
into their local address books (depending on permissions and
maximums set by the administrator).
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System requirements

• Power Macintosh with System 7.5.3 or later, Open
Transport 1.1.2 or later. Free RAM needed: Virtual
Memory on: 3.5–5MB; VM off: 6–7.5MB. Disk space: 3MB
+ 4K per entry.

• If integrating with AppleShare: AppleShare IP 5.0 or later
and the AppleShare IP Registry API extension (a shared
library found on your AppleShare IP install CD-ROM).

• The extension “OpenTptInternetLib” must be present in
the Extensions folder. For Systems 7.5–7.6.1,
AppleScriptLib, InterfaceLib, MathLib, and
ObjectSupportLib must also be present. These are all part
of your normal Mac OS. If one is missing, an alert is
displayed when ClickMail is opened.

• TCP/IP (Open Transport) must be properly configured.

• ClickMail is designed to be accessed by LDAP-aware
clients (on Mac, Windows, and Unix) such as Netscape
Communicator, Eudora Pro 4*, Mulberry, QuickMail Pro,
Outlook Express, Sherlock 2 (with plug-in), and Mac OS 9
Network Browser.

*For proper operation, use Eudora Pro 4.01 or later
(http://eudora.qualcomm.com/pro_email/updaters.html)

System requirements

http://eudora.qualcomm.com/pro_email/updaters.html
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Getting started

Installing ClickMail

1. Double-click the ClickMail Installer program on your hard
disk or floppy disk. Read the Read Me message (displayed
by the installer) for late-breaking news.

2. Whether you are installing for the first time or upgrading,
Easy Install will do the right thing. If you wish, select any
folder or disk to contain the ClickMail folder. Click the
Install button, and respond to any onscreen messages.
When it’s finished, quit the installer.

3. If integrating with AppleShare, copy the library file
“AppleShare IP Registry API” from your AppleShare IP
CD-ROM to the Extensions folder.

• There is no need to restart the Macintosh.

4. If this is a purchased copy (rather than evaluation), open
ClickMail from the Finder and choose Serial Number…
from the Edit menu. Enter your serial number and click
OK. If you do not enter a serial number, ClickMail runs
for 30 days as an evaluation.

Files installed in the ClickMail folder

ClickMail C.D.

The application program that does all the work.

Import/Data Utility.fm3

This FileMaker 3 document may be used to prepare
data for importing into ClickMail. It can also be
handy for offline manipulation of data from your

running ClickMail directory. See Export/Import for more
information.

Getting started
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Example directory datafile, Example directory datafile keys

These two files are an example directory for
you to try. Do not store your real data here—
create your own datafile.

ClickMail C.D. Admin Guide.pdf

The online version of this guide. It is enhanced with
bookmarks, clickable contents and index, hyperlinks,
and an Acrobat Search catalog for fast searching.

ClickMail 1.x Read Me, Software License Agreement, Order
Form, and Import File Example (AppleScript)

The usual suspects. Read “ClickMail 1.x Read Me” for
additional information that may not be in this guide.

Other ClickMail files

ClickMail LDAP Preferences

This file, located in the Preferences folder, is created by
ClickMail when it is launched. Here it remembers which
datafile to open, and other settings.

A ClickMail directory is stored in a matching
pair of files. You name the first file, ClickMail
gives the second file the same name plus

“keys.” We refer to this pair as a “datafile.” Be sure to keep
these files paired—for example, don’t restore one from a
backup without the other. You may create as many datafiles
as you wish, but only one is open/in use at a time.

• A datafile should not be copied or backed up while it is
open (ClickMail is using it). This is because a copy of a
file in an open state cannot be reopened later. To copy
the datafile, make a backup with ClickMail’s Backup
command (File menu), then copy the two backup files.

Getting started



9

Test drive ClickMail

Let’s take it for a spin. This will help you get familiar with
how it works before setting up your own directory.

Opening the example directory

1. Double-click the ClickMail C.D. application. The Configure
Directory Server window appears. (If it doesn’t appear,
from the File menu choose Configure….)

2. For this tryout, the “Stand-alone server” radio button
should be selected.

3. In the Datafile box, click the Open… button. Open the file
“Example directory datafile” in the ClickMail folder.

Configure directory server window.

Getting started
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3. Enter your email address in “Administrator’s Email.” The
software may use this later to notify you in certain cases.

4. Click OK. ClickMail opens the example datafile (as noted
in the ClickMail Log window). It’s ready to look up email
addresses!

Looking at the entries

1. From the Database menu, choose Entries…. In the Entry
window, you may add, delete, and edit entries (records) in
the directory.

2. Look over the first entry. In the scroll list, there is a
column of attribute names and a column of values of those
attributes. Browse through some entries by clicking the
right or left arrow buttons.

Entry window.

Getting started
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Each data field, or attribute, has an attribute name
and one or more values. ClickMail always presents
attribute names in plain English, rather than the
sometimes obscure LDAP terms. For example, the
LDAP attribute “sn” is called “last name (sn)” in
ClickMail. The actual LDAP term is used when
communicating with LDAP clients, and also in
distinguished names.

• Each entry has a unique name, called the
distinguished name (shown at the top of the
window). This name distinguishes one entry from
another—it’s the label for the whole entry. The
common name (cn) attribute is often used for the first
part of the distinguished name. The last part of the
distinguished name is the naming context. It’s usually
the country you are in (in this case “c=US”).

3. In an entry, click the email address. It appears in the edit
box below the list. Make a change to the address, press tab
or return, then click Save. You’ve now edited an entry.

4. When you’re done, close the Entry window.

Looking up with a client program

The goal here is to look up addresses from an email client, so
let’s do that. You will need an LDAP-aware client program
such as Netscape Communicator, Outlook, Eudora Pro 4,
Mulberry, or QuickMail Pro. If you’d like to try Sherlock 2 or
Network Browser with ClickMail, see our web site. Always
run the client on a different machine than ClickMail. The
client must have TCP/IP properly configured.

You need to know the IP address or host name (if any) for the
Mac running ClickMail. Usually you can find this in the TCP/
IP control panel. Next, open your client and follow our
directions for Eudora, Netscape, or Outlook in this chapter.
For more information about a client, or for Mulberry or
QuickMail Pro, see the Client Programs chapter.

Getting started

http://www.gracion.com/server/sherlock/
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Eudora Pro 4

1. From the Special Menu, choose Settings.

2. Click the Hosts icon.

3. In the Directory Services field, enter a URL for the Mac
running ClickMail, starting with “ldap://”.

Examples:
ldap://ldap.mydomain.com/ ldap://123.45.67.89/

Click OK to save the settings.

4. From the Window menu, choose Directory Services.

5. In the Entry query field, type “Flint*” and press return.
Several entries are listed in the large field.

Eudora Pro Directory Services window.

Getting started
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6. Click in any entry, then click the To button. A message
window opens, pre-addressed to the person you selected.
Discard the message when you’re done.

Netscape Communicator 4.5

1. From the Communicator menu, choose Address Book.

2. From the File menu, choose New Directory. This opens the
LDAP Server Properties window.

• Older versions of Communicator do not have a New
Directory command in the File menu. Add new
directories under Edit->Preferences->Mail &
Newsgroups->Directory, New (button).

3. In Description, enter “ClickMail Directory” (or whatever
name suits you).

4. In LDAP Server, enter the host name or IP address of the
Mac running ClickMail.

Examples: ldap.mydomain.com 123.45.67.89

5. You can leave the other fields as they are (Search Root
blank, Port Number 389, etc.). Click OK. The Directory is
added to the left pane of your Address Book. Select it.

Netscape Communicator Address Book window.

Getting started
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6. In the “Show names containing” field, type “Flint”. Press
return.

7. Select a name from the list that appears. Click the “Send a
message” icon button to create a message to that person.
Discard the message when you’re done.

Outlook Express (Mac)

1. From the Edit menu, choose Preferences.

2. On the left side of the window, choose Directory Services.

3. At the top, click the New Directory… button. In the New
Account window which appears, enter “ClickMail
Directory” (just for your reference). Click OK.

4. In Server address, enter the host name or IP address of
the Mac running ClickMail.

Examples: ldap.mydomain.com 123.45.67.89

5. Click the Advanced… button. Make sure Search base is
empty, and all the checkboxes are unchecked. Click OK.
Then Click OK to close the Preferences window.

• Making changes to LDAP settings in Internet Config
may alter your Outlook directory preferences and

Outlook Express directory pane.

Getting started
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prevent it from working correctly. Leave Internet
Config alone for now.

6. On the left side of the Outlook Express window, choose
ClickMail Directory. Under our name in nice large
lettering, enter “Fred” in the Search for Name field. Click
the Find button.

7. Select a name in the list that appears, then click the Mail
to: button. This opens a message to that person. Discard
the message when you’re done.

Next, get real!

This concludes the test drive. The next section, Setting up a
directory, guides you through the task of setting up your
own data for access by your users.

Getting started
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Setting up a directory

Your data

Decide what attributes you want to store (email address,
phone, etc.). The simplest option is to use our default
“emailPerson,” which covers the attributes shown by most
clients in their list views. You may add other attributes to
your entries. Or, use a standard schema (inetOrgPerson,
LIPS, etc.). For a detailed discussion, see the Kinds of
Directories and Client Programs sections.

• For a handy list of standard attributes (in addition
those in our simplified emailPerson), open the
Attributes Reference window (File menu).

Input: Entries may be imported in any of three formats
(LDIF, tab-delimited, or vCard) or entered directly in
ClickMail. Changes to entries may only be made directly in
ClickMail (or via Web in ClickMail XL)—changes via LDAP
are not yet supported. However, all entries may be exported
for offline maintenance, then reimported.

ClickMail may be run as a “mirror” to your AppleShare IP
Users & Groups Registry. When you open the directory with
this setting, all AppleShare users appear in ClickMail’s
directory. Also, entries entered or imported into ClickMail can
be placed into Users & Groups automatically.

Making a new directory

1. Launch ClickMail and immediately hold down the shift
key. The Configure Directory Server window appears.

• If ClickMail is already running, from the File menu
choose Configure….

2. Choose the type of database, stand-alone or AppleShare
mirror. Enter the administrator’s email address.

Setting up a directory
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• AppleShare mirror only: fill in administrator’s name,
password, and email domain. If user names in
AppleShare’s Users & Groups are surname-before-
given name, check one or both of the “Last, First” and
“Last First” boxes. If a comma is included in some or all
AppleShare entries, check “Last, First.” If the surname
appears first without a comma, check “Last First.”

3. Click New, name your datafile (use a name no longer than
18 characters), and click Save. Click OK in the Configure
window.

4. In the “Naming Context” window, enter “c=US” (or c= your
own country’s code). Your new directory is now created.

• AppleShare mirror only: You are prompted to choose an
AppleShare Server from those available on the
network. Next, the AppleShare users are copied into
the directory and indexed. This may take a while.
When it’s done, the splash screen goes by and the log
shows “IP LDAP Daemon  LDAP Daemon Opened.”

5. From the File menu, choose Logging…. Choose the desired
type and level of logging.

• Suggestion: Set window and file logging, “Important”
level (“All” gives a very large amount of detail and
greatly slows down the server). The log file is a plain
text file found in the same folder as ClickMail.

6. From the Database menu, choose Permissions…. Check
the Everyone box so that users can access the directory. To

Setting directory access for a range of IP addresses.

Setting up a directory
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limit access to only your group or company, check the
“whose IP is in the range” box and enter the range of IP
addresses of your users’ computers in the text field.
(Example: 123.45.67.1 - 123.45.67.255). Write
permissions should be left off (unchecked) in most cases.

7. From the Edit menu, choose Preferences…. We
recommend you check the “Backup daily?” and “Compact
Daily?” boxes and set appropriate times. The Backup
setting creates a closed backup copy of the current datafile
automatically each day. The Compact setting ensures that
unused space in the datafile is removed more frequently.
If Compact is unchecked, the datafile is still compacted
when necessary.

• AppleShare mirror only: If you want newly created or
imported entries to be added to ASIP Users & Groups
by default, check “Add new entries to ASIP Users &
Groups.” If you want passwords from AppleShare
copied into all ClickMail mirror entries, check “Copy
passwords from ASIP Users & Groups.” Passwords are
hidden from LDAP clients by default (see Permissions
and Security). To cause ClickMail to resynchronize its
entries with AppleShare Users & Groups daily, check
“Sync to AppleShare daily” and enter a time of day.

IMPORTANT: Only a backup or closed version of the
datafile can be restored for later use. Make a backup
copy of your directory at this time by choosing Backup from
the File menu. Then move the files “copy of <your datafile
name>” and “copy of <your datafile name> keys” (created by
the Backup command) to a backup storage device. Move or

Domain Specific Entry (DSE) as seen in entry window.

Setting up a directory
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copy these files for backup, not the open datafile. We
recommend that you back up the two files daily (using
the preference setting) or whenever you make a
change to the data.

Special entries

In each new directory, ClickMail creates two entries required
by LDAP. They are mentioned here because you will see them
in the Entry window. These rarely need to be changed.

If you wish, skip to Importing Entries on the next page and
read this part later.

Domain Specific Entry (DSE): This is the “top” entry. Its
distinguished name is “” (an empty string). Its three required
attributes are namingContexts (usually one, which you just
entered), subschemaSubentry (a list of distinguished
names of subschema entries), and entry type (objectClass)
(always “*”). The DSE cannot be deleted.

Subschema Entry: This describes an entry type
(objectClass) used in your directory to describe a schema. Its
common name is the name of the entry type (our default:
emailPerson). attributeTypes lists the attributes that may
appear in each entry. objectClasses lists the objectClass and
its parents (don’t confuse this with the entry type attribute,
whose LDAP name is objectClass, singular). To be LDAPv3

Subschema Entry as seen in entry window.

Setting up a directory
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compliant, the directory must contain at least one subschema
entry. ClickMail automatically creates an entry called
“emailPerson.” It is designed to cover the attributes expected
by the major email clients. You may edit or replace this entry
to support different LDAP schemas.

Importing entries

If you have a list of user names and addresses in tab-
delimited format, you can probably import them directly into
ClickMail. Among your tab-delimited fields (columns), you
must have either a full name field or separate first name and
last name fields. And, you should know the order of the fields
in your tab-delimited file. ClickMail can also import LDIF
text files. For a more detailed look at importing, see the
Export/Import section later in this guide.

• If you are running ClickMail as an AppleShare mirror,
users in AppleShare’s Users & Groups are
automatically imported by ClickMail. You do not need
to use the Import command. See Your Data, above.

• If you want to type your entries directly into ClickMail,
see Typing new entries into ClickMail.

1. To import entries, from the File menu, choose Import—
Tab-delimited. This brings up the Import Tab-delimited
window, containing a list of attribute names.

2. A newly-installed ClickMail shows a list of standard fields,
those commonly used in directories. If no fields are listed,
from the Lists menu, choose Standard Fields. Edit the list
so that it matches the order of fields in your tab-delimited
file. In the list, line 1=field 1, line 2=field 2, etc.

The name game

If you are importing using full names, list the common name
(cn) in the position where the full names are in your file. If
you are importing separate first and last names, use the first
name and last name (sn) items. Use copy and paste to line up

Setting up a directory
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the field names in the same order as they appear in your file.
Leave a blank line to skip over any unused fields in your file.
Delete all names that you are not importing.

• Don’t use distinguished name (dn) unless you are
actually importing formatted distinguished names.

• Imported entries are given the type “emailPerson”
unless you import an entry type (objectClass) field.
If you do import this field, the Email Persons Only
checkbox prevents non-person entries (such as schema
entries) from being imported.

3. Before you import, you may save the list itself as a file.
From the Lists menu, choose Save Field List…

4. Click Import. Choose your tab-delimited file from the
Open File dialog. The entries in the file are then imported
and indexed. This may take a while, depending on the size
of your data. The log file reports any rejected records.

Once your entries are
imported, make sure
they are valid by
viewing them in the
Entry window.

Importing vCards

If you have vCard files
(file extension .vcf)
you wish to import,
simply select them all
in the Finder and drag
and drop them on the
ClickMail application
icon. Or, import each
file using ClickMail’s
Import vCard
command under the
File menu. Additional

Setting up a directory

Import Tab-Delimited window with
standard field list.



22

vCards may be dropped on the ClickMail application icon at
any time.

Typing new entries into ClickMail

Instead of importing, you may create entries directly in
ClickMail. You should already have completed Making a
new directory, above.

1. To open the Entry window, from the Database menu,
choose Entries….

2. Click the Add Entry button: . An unnamed user entry
appears.

3. Tab to enter the first attribute, which is common name.
Type in the full name of a person (“John Smith”). Typing is
done in the edit field near the bottom of the window. Tab
to the next field.

Setting up a directory

Typing a new entry into the entry window.
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4. Enter values for the attributes, skipping those you are not
interested in. At a minimum, enter common name, first
and last names, and email address. Entry type is filled in
for you.

5. Check your work, then click Save. Any unused attributes
are removed from the entry.

6. Repeat steps 2 through 5 for each person.

7. When you are finished, from the File menu, choose
Backup. This creates a backup copy of the two files that
make up the directory database (a database file and a
“keys” file). For the backup function to succeed, your
database filename must be 18 or fewer characters. (To
rename, quit ClickMail, rename both files in the Finder,
then restart ClickMail and open with the new name.)

8. Your directory is ready for use!

Setting up a directory
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Working with entries

Browsing entries

To open the Entry window, from the Database menu, choose
Entries…. The window title is the name of your datafile. To
browse among entries use the left and right arrow buttons at
top left.

The up and down arrows are for tree-style (parent-child)
browsing. You can ignore these for most basic directories. To
see the parent of an entry, click the up arrow. To browse
among the children of an entry, click the down arrow.

• Tree-style directories: The number of children of the
current entry is displayed next to the down arrow.

Finding entries

To find one or more specific entries, choose Find Mode from
the pop-up menu at upper right. In Find Mode, all the
attributes used in any directory entry are listed. Enter all or
part of the text of one or more attribute values, then
click Find. The values are treated as substrings. If you want
an exact value, type an equal sign in front of the value
(“=Smith”). You can specify all values greater than or equal to
(or less than or equal to) the entered value (this compares
alphabetically, not numerically). Examples: “>=Jones” or
“<=Smith”.

If you enter values in several attributes, only entries that
contain all the values are returned (this is a boolean AND of

Working with entries

View next

View previous View parent

View child

Add entry

Add child

Duplicate entry

Edit/find mode pop-up
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the values). Searches are not case sensitive. Accented letters
in entries are a match for their plain text equivalents you
enter in find mode (“e” finds “é,” “ê,” etc.).

After a Find, you may browse and edit the found set of
entries. The number of entries found is displayed at the
bottom. Clicking the left and right arrows browses only the
found set. To go back to browsing all entries, choose Find all
from the pop-up menu.

To find group entries, subschemas, or the DSE, use the
shortcut commands in the Entries menu, which is active
when the Entries window is open.

Editing an entry

You may edit the entry being viewed. Any changes to the
entry are saved to disk when you click Save or move to a
different entry (similar to the behavior of FileMaker). Turn on
balloon help for button explanations.

To add an attribute to the current entry, choose it by name
from the Add Attribute pop-up menu (choose Other… if you
don’t see the one you want).

To add additional values to an attribute (such as multiple
common names), select the attribute in the scrolling list and
click the Add Value button.

When you add a new attribute (or value), type the value into
the edit field near the bottom of the window. To “enter” the

Working with entries

Value edit field Add attribute pop-up Add, Delete value buttons

Edit controls in the Entry window
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value, click any button or pop-up, press the tab or return key,
or click in the window’s margins.

To delete an attribute value, select it in the scrolling list and
click Delete Value.

To edit an attribute value, click it in the scrolling list. The
value appears in the edit field. Edit the value in that field. To
“enter” the change, click any button or pop-up, press the tab
or return key, or click in the window’s margins.

Adding an entry

To add a new entry, click an Add entry button (one of the
three “ ” buttons at the top of the entry window). The first
button  adds a blank entry. The second button  adds
a blank entry as a child of the current entry (don’t use this
unless you are organizing your entries in a tree structure).
The third button  adds a duplicate entry, just like the
current entry, except with a common name of “unnamed.”

The “blank entry” is actually an entry with all the
emailPerson attributes in place. Tab into the first attribute
(common name), and replace “unnamed” with the full name of
this person. Tab to the next field and continuing entering
data. Skip over the attributes you don’t want. To add any
attributes that are not listed, use the Add Attribute pop-up
menu. When you are finished, click Save. Any attributes that
you left blank are removed when you first save the entry.

Deleting an entry

To delete an entry, view it in the entry window and click the
Delete button. If you organize your entries in a parent-child
tree, the Delete button is disabled if the entry has any child
entries. In that case, you must delete the child entries first.

Working with entries
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Distinguished name in the entry window

The distinguished name (dn) for the entry appears in a
separate field at the top of the entry window. This may not be
edited directly, but you can change its value.

The first part of a dn always appears as an entry attribute
value, shown in bold. (This part is sometimes called the
relative distinguished name or rdn). If you edit the bold
attribute value, the dn is also changed. To use a different
attribute value, double-click the other value in the attribute
list. The new value becomes bold and becomes the new first
part of the dn.

Working with entries

First part of dn Bold attribute value

Value in bold is used as first part of distinguished name.

Delete entry Revert to
saved version

Save entry
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Understanding ClickMail and
directories

Launching ClickMail

When ClickMail is launched (opened), it opens the last
datafile used (as stored in its preferences). If there is an error
opening the file (for example, it has been renamed or moved),
the Configure window is opened and the error is shown, so
that you can choose or create a new file.

If a datafile is double-clicked in the Finder, that datafile is
opened in ClickMail (whether or not ClickMail was already
running). Using the open command in AppleScript on a
datafile has the same effect.

Mirroring AppleShare

When “AppleShare Mirror” is selected in ClickMail’s
Configure window, the database downloads all users from an
AppleShare Users & Groups Registry, and maintains “mirror”
entries in the ClickMail datafile.

Any changes made in ClickMail to AppleShare users are
automatically made to their Users & Groups entry as well, for
certain attributes that
appear in AppleShare.
AppleShare changes
supported by ClickMail
include add user, delete
user, set Alias (the
username part of the
email address), and set
password. The changes
are reflected in
AppleShare as soon as
the ClickMail entry is
saved.

Understanding ClickMail and directories

AppleShare user as seen in AppleShare
Admin’s Users & Groups display.
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ClickMail attributes that are kept in sync with AppleShare
are common name (cn), email (before the “@”, as AppleShare
User Alias), user access flags, and password (if present in the
ClickMail entry or enabled for all entries under ClickMail
Preferences.)

Newly added AppleShare users have two settings enabled:
“User may log on” and “User may change password.”

• In the current version of ClickMail, a new user’s
default AppleShare mail setting is “No Mail.” To enable
an AppleShare mail account, you must use the
AppleShare IP Web & File Admin or AppleShare IP
Mail Admin program.

Changes made in AppleShare are detected in ClickMail only
when ClickMail performs a synchronize function. This occurs
whenever ClickMail is started, when “Resync from
AppleShare” is chosen from the File menu, and when
scheduled under ClickMail Preferences. To bring ClickMail
up to date after making AppleShare changes, choose the
“Resync from AppleShare” command. When practical, make
AppleShare user changes in ClickMail to avoid the need to
resynchronize.

Understanding ClickMail and directories

The same user mirrored in ClickMail. User icon at lower
left indicates this is a mirrored AppleShare user.
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AppleShare IP groups are mirrored as separate entries of type
“asipgroup” (an LDAP objectClass). This allows listing group
email addresses that can be found by LDAP client searches.
These entries are not regular LDAP “groupOfPersons” groups.
Group membership must be assigned in AppleShare IP Web
& File Admin.

AppleShare IP user access flags are included in mirror entries
in the “asipflags” attribute. The flags are displayed in
hexadecimal (preceded by “16#”) and may be edited. Editing is
only recommended if you are familiar with the flags and their
effects in AppleShare IP.

What is an entry?

The directory contains entries. Entries may represent
persons, roles, machines, programs, server volumes, web
sites, or anything else you may want to look up. The most
common use for an LDAP server such as ClickMail is for
looking up people’s email addresses.

Each entry contains attributes, such as common name, email
address, phone number, etc. Decide what information you
want to store about each person. One criteria may be what
types of data are supported/displayed by the LDAP client
programs you intend to use. To make this easy, ClickMail’s
default entry type, “emailPerson,” includes the primary fields
for the programs listed in our Clients section below.

Distinguished Names—the unique identifiers for entries

Each entry has a unique name, called the distinguished name
(or dn), a label which is used to find and identify that entry. It
consists of a list of data values, ordered from small (such as
common name) to large (such as country). Some examples:

cn=Janet Smith, c=US
cn=“James Smith, Jr.”, o=Some Company, c=US
o=“Acme, Inc.”, c=US

Understanding ClickMail and directories
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ou=Creative Dept., o=”Acme, Inc.”, c=US
cn=Andy Jones, ou=Creative Dept., o=”Acme, Inc.”, c=US

Notice that the last three examples build on each other from
right to left. Any entry can be a parent of other entries, if the
child entries’ dn’s are built from the parent’s dn by adding a
new name on the left. This could be used by a company to list
departments (“ou” means organizational unit), which contain
people. Although ClickMail supports this kind of parent-child
structure, it is not needed for basic email lookups. All you
need is an identifier (cn=Janet Smith) followed by your
naming context (c=US).

Understanding ClickMail and directories
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You can choose what attribute you use for first part of the dn.
It’s traditional to use the common name, but for large groups
where two people may have the same full name, a username
(from the email address) or ID number could be used.

You must choose a naming context for the entire directory,
typically the country your organization is in (“c=US”). You
could also include the organization name (“o=Acme
Manufacturing, c=US”), but making it an attribute in
individual entries is more flexible.

Basic email lookup directory

The simplest application of LDAP is for email-address
lookups within a group or company. All you need is an entry
for each local user, with at least a name and email address.
Depending on the client programs being used, various other
attributes (phone, department, etc.) may optionally be used
and viewed.

A flat directory structure is simplest and often works great.
Each entry’s distinguished name consists of two parts: the
user’s identifier (usually common name), and naming context
(usually your country).

• Examples of distinguished names from three different
flat directories:
cn=Betsy Ross, c=US
cn=William Shakespere, c=UK
uid=12345, c=US

Understanding ClickMail and directories

cn=Paul Revere, c=UScn=Betsy Ross, c=US cn=Patrick Henry, c=US subschema
cn=emailPerson, c=US

DSE

Outline of a flat directory. The naming context is “c=US.” The two
shaded entries are required and automatically created in each new
datafile (see Special Entries).
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You can put all your entries at the “top” level of the directory
simply by avoiding the “New Child” command.

• The directions in Setting Up A Directory result in a
flat directory.

Tree directory

A directory may be organized in a tree structure, representing
the divisions, departments, and people in an organization.
Advantages over flat: The tree directory allows two people to
have the same full name, department listings can be created,
it’s a more organized way to manage a large directory. To
illustrate, here is an example for a company, using a naming
context of c=US.

At the top, the company itself has an entry. Instead of a
common name, it has an organization name. Its distinguished
name is o=Acme Co., c=US. It’s entry type is organization.

• When entering a new entry, ClickMail defaults to using
the common name in the distinguished name. When

Understanding ClickMail and directories

subschema
cn=emailPerson, c=US

DSE

o=Acme Co., c=US

ou=Western Division, o=Acme Co., c=US ou=Eastern Division, o=Acme Co., c=US

ou=Production, ou=Western Division,
o=Acme Co., c=US

ou=Sales, ou=Western Division,
o=Acme Co., c=US

cn=Grant Landes, ou=Sales,
ou=Western Division, o=Acme Co., c=US

cn=Maria Dominguez, ou=Sales,
ou=Western Division, o=Acme Co., c=US

Outline of a tree-structured directory. The naming context is “c=US.”
The two shaded entries are required and automatically created in
each new datafile (see Special Entries).
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entering the company, you would double-click Acme Co.
in the attributes list to use the organization name
instead. Also, you would change entry type in the
attributes list.

The company has two divisions. These are represented by
child entries whose parent is the company entry. Their
distinguished names are ou=Western Division, o=Acme Co.,
c=US and ou=Eastern Division, o=Acme Co., c=US. Their
entry type is organizationalUnit. The attribute used to name
them, “ou,” stands for organizational unit (meaning
organizational unit name). In ClickMail, this attribute is
called “department/unit (ou).”

• To create these division entries in ClickMail, you would
view the company entry, then click the add child button

 to create a division entry. If you are viewing a
child entry, the add button  creates a “sibling.”

Each division contains departments. The Western division
has Sales and Production departments. To represent these,
we use organizational units again (you can have any number
of levels of them). Their distinguished names are ou=Sales,
ou=Western Division, o=Acme Co., c=US and ou=Production,
ou=Western Division, o=Acme Co., c=US. (The eastern
division is left as an exercise for the reader.)

At last we can add some people! Maria and Grant work in the
western sales department. Their distinguished names are
cn=Maria Dominguez, ou=Sales, ou=Western Division,
o=Acme Co., c=US and cn=Grant Landes, ou=Sales,
ou=Western Division, o=Acme Co., c=US .

Formal X.500-style directory

If you know X.500, you know what you want. Check the Read
Me file for any LDAP/X.500 features that may not be
implemented in this version.

Understanding ClickMail and directories
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Other kinds of entries

Directories need not necessarily be for email addresses or
even for people. For example, an LDAP directory may be used
by programs on users’ computers to look up file server IP
addresses. Here are some other entry types that are used in
LDAP/X.500 directories:

organizationalRole
residentialPerson
applicationProcess
applicationEntity
device
groupOfNames

Another kind of entry, type “alias,” is used to refer to a single
entry under a different name or from a different part of a
tree-style directory. To create an alias entry, set the type to
“alias” and add attribute “aliasedEntryName” which must
contain the DN of the entry being aliased. To find all aliases
to an entry, search for that entry’s DN in the
aliasedEntryName attribute. To understand the effect and
use of aliases in LDAP, see RFC 2251.

User strategy: an example

It’s worth considering how your users can best make use of
the directory. Here’s a possible set of directions—adapt this
for your own situation:

1. As a new user, read all the entries from the central
directory (search for “*”), or if that’s too many, a set of
useful entries, such as your department. Keep these in
your email program’s local address book for easy use.

2. If the person you want to mail to is not in your address
book, search for their name in the central directory.

3. If some mail you sent bounces back, search the central
directory for a new address.

Understanding ClickMail and directories
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LDAP Write

Although most LDAP clients only search and read data from
servers, LDAP includes a Write function for updating
directory entries. ClickMail supports this function. LDAP
Write is disabled by default in new datafiles.

To Enable LDAP write operations, from the Database menu
choose Permissions. Under Write, check “Logged in Users.”
We recommend that you also define a permitted IP range for
a little more security. Next, add a password to the entry(ies)
of the person(s) who should be permitted write access. For
write access, the client must log in with this person's
Distinguished Name and password.

One publicly available Macintosh LDAP read/write client,
MaX.500 from University of Michigan, can browse and edit
existing entries, but not add new ones. Use the "non-UMich"
install option, and set your directory and Searchbase options
before searching (http://www.umich.edu/~dirsvcs/ldap/
max500/).

ClickMail supports LDAP write operations Add, Delete,
Modify, ModifyDN, and Abandon.

• Warning: There is no encryption or security protocol
used with ClickMail's password login or write
operations. Passwords can be easily revealed as they
travel "in the clear" between client and server. If this
server is used over the Internet, be aware that
passwords, and therefore your LDAP data, are subject
to interception and modification by outsiders. Do not
use the same passwords used for other services such as
email or FTP (although FTP passwords aren't secure
either).

Understanding ClickMail and directories
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Client programs

Any LDAP-aware email software running on any OS (Mac,
Windows, Unix) should be compatible with ClickMail.

Generic directions

1. Configure the client with the IP address or host name of
the server where ClickMail resides.

2. Search for “*” to load all available entries into the local
address list.

3. Search for specific entries by name and/or other attribute
(if allowed by the client).

• Special characters: client programs use several
character sets for special characters (é, £, etc.).
ClickMail does everything possible to detect which
character set a client is using. For details, see the
preference for Default LDAP Client Character Set.

Eudora Pro 4

• Use version 4.01 or later—4.0 searches don’t return
any entries.

• Does not support user login; guest access only.

Setup

1. From the Special Menu, choose Settings.

2. Click the Hosts icon.

3. In the Directory Services field enter a URL for the Mac
running ClickMail.

Examples:
ldap://ldap.mydomain.com ldap://123.45.67.89

Client programs
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4. Click OK to save the settings.

5. Optionally, check “Live” directory service queries (for
details, turn on balloon help).

Search

1. From the Window menu, choose Directory Services.

2a. Live preference unchecked: In the “Entry query” field, type
a full name, or part of a name with asterisks before and/or
after as wildcards. (Example: Flin* finds “Flintstone,
Flinny, or Flin.) Press return.

2b. Live preference checked: Type all or part of a name.

3. Returned entries are listed in the large scrolling field.

Client programs

Eudora Pro Directory Services window.
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4. Click anywhere in an entry to select it. To send a message,
click the To, Cc, or Bcc, button. To store the entry in your
address book, from the Special menu choose Make Address
Book Entry….

• If you get an error saying the “Eudora LDAP Library”
is missing, use Find File to search for a file by that
name. It belongs in the Eudora Stuff folder (alongside
the Eudora Pro application).

Mulberry

• Supports user login as of version 1.4.

• Supports multiple LDAP server choice as of 1.4.

• ClickMail and Mulberry have been reported to freeze
on some Macs if Mulberry is running on the same Mac
as ClickMail and does an LDAP lookup. There is no
problem when run on a different Mac than ClickMail.

Setup

1. From the File menu, choose Preferences…. On the left side
of the Preferences window, click Addresses.

2. From the Account pop-up, choose New…. Enter any name
to refer to your ClickMail server. Click OK.

3. In the Server field, enter the host name or IP address of
the Mac running ClickMail.

Examples: ldap.mydomain.com 123.45.67.89

4. Leave Root blank. The other fields specify LDAP attribute
names understood by your server. If desired, for Address,
phone, and Fax, enter postalAddress, telephoneNumber,
and facsimileTelephoneNumber.

5. To have all other attributes read and captured in the notes
field, check the box Put Attributes in Notes.

Client programs
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• Mulberry 1.3 searches all LDAP servers when you
search, listing the results from each server separately.
Therefore, another LDAP server may be searched
before ClickMail. To avoid this, you may delete the Test
Server or other LDAP accounts in the pop-up. Choose
the other account from the pop-up, then choose
Delete… from the pop-up.

Search

1. From the Addresses menu, choose Search…. This opens
the Address Search window.

2. In the window, from the find Items pop-up, choose “using
LDAP.”

3. Enter a full or partial name in the text field. If desired,
change the Contains pop-up to another option.

4. Click the Search button. A list of returned entries appears
under the name you entered, outline-style. If you search
again, the results are added to the list under another
entry header.

5. To see the details of an entry, double-click it.

6. To add an entry to an address book, drag it to an open
address book (icon or window).

7. To address a
message, from
the File menu
choose New
Message. Drag
any entry from
the search list to
the To or other
field in the
message
window.

Client programs

Mulberry Address Search window.
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Netscape Communicator 4.5

• Does not support user login; guest access only.

• Uses standard attribute names (which are described in
the LDAP protocol RFC 2256 and ITU-T X.521) when
searching the directory. These include the following
attributes: cn (common name), givenName (first name),
sn (last name), mail (email), telephoneNumber (work
phone), o (organization name), ou (department/unit), l
(city/location), and street.

• Can display any and all user attributes by using an
LDAP URL in the browser window. You can do this by
double-clicking an entry in the Search Directory
window (not the Address Book window). This function
has been reported to freeze when Netscape is on the
same Mac as ClickMail.

• Communicator Professional Edition may allow
customizing of attributes used/displayed (see
http://developer.netscape.com/library/documentation/
communicator/custom.htm).

Setup

1. From the Communicator menu, choose Address Book.

2. From the File menu, choose New Directory. This opens the
LDAP Server Properties window.

• Older versions of Communicator do not have a New
Directory command in the File menu. Add new
directories under Edit->Preferences->Mail &
Newsgroups->Directory, New (button).

3. In Description, enter “ClickMail Directory” (or whatever
name suits you).

4. In LDAP Server, enter the host name or IP address of the
Mac running ClickMail.

Examples: ldap.mydomain.com 123.45.67.89

Client programs
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5. You can leave the other fields as they are (Search Root
blank, Port Number 389, etc.). Click OK. The Directory is
added to the left pane of your Address Book. Select it.

Search (basic)

1. From the Communicator menu, choose Address Book. In
the window’s left pane, select the ClickMail directory you
created above.

2. In the “Show names containing” field, type all or part of
the name you want to find. Netscape searches for entries
whose common name attribute contains your text. To
retrieve all entries, enter an asterisk (*). Press return to
search.

3. Select a name from the list that appears. Click the New
Msg icon button to create a message to that person.

Search (advanced)

1. From the Communicator menu, choose Address Book. In
the window’s left pane, select the ClickMail directory you
created above.

Client programs

Netscape Communicator Address Book window.
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2. Click the “Search for…” button, which opens the advanced
Search window.

3. Choose an attribute from the first pop-up menu, and enter
a full or partial name in the text field. Or, select another
attribute to search in. Use the More button to restrict your
search using multiple attributes.

4. Click Search. A list of entries is retrieved from the
directory.

5. Select one or more entries. To store in your personal
address book, drag them there. To compose a message,
click the New Msg icon button. To see all attributes for an
entry, double-click it.

Outlook Express

Setup

1. From the Edit menu, choose Preferences.

2. On the left side of the window, choose Directory Services.

3. At the top, click the New Directory… button. In the New
Account window which appears, enter a name for your
reference. Click OK.

4. In Server address, enter the address of the Mac running
ClickMail.

Examples: ldap.mydomain.com 123.45.67.89

5. Click the Advanced… button. Make sure Search base is
empty and all the checkboxes are unchecked. Click OK.
Then Click OK to close the Preferences window.

• Making any changes to LDAP settings in Internet
Config may alter your Outlook directory preferences
and prevent it from working correctly. Leave Internet
Config alone for now.

Client programs
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• The “simple search” preference (under Advanced) limits
the search to only cn and mail attributes. It’s not
needed for ClickMail. In fact, this setting can be
confusing to users, because a last name search won’t
work unless the user enters an asterisk in front of
the name.

Search

1. On the left side of the Outlook Express window, choose the
ClickMail directory.

2. In the directory area, enter a full name or beginning of a
name in the Search for Name field.

• The Search for Name field actually searches numerous
attributes for values that begin with what the person
enters. To search for a substring anywhere in
attributes, enter a leading asterisk (“*Smith”) .Outlook
displays the separate first and last name attributes
rather than common name.

3. Click the Find button. A list of names is returned.

4. To address a message, select a name in the list, then click
the Mail to: button (along the top of the window). This
opens a message to that person. Discard the message
when you’re done.

Client programs

Outlook Express directory pane.
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5. To keep entries in your contacts book, drag them to the
contacts icon at left.

6. To see more information about an entry, double-click it.

• Outlook’s contacts address book accepts a large number
of attributes. You can include these in your entries to
provide more information to Outlook users.

Fields supported by Outlook in contact view:

Outlook field name ClickMail name(s)
LastName last name, common name
FirstName first name
EmailAddressDefaultFieldID email
BusinessCompany organization name
BusinessCountry country
BusinessDepartment department/unit
BusinessFax fax
BusinessPager pager
BusinessPhone work phone
BusinessState state
BusinessStreetAddr postal address, street
BusinessTitle title
BusinessZip zip/postal code
HomeWebPage URL
HomePhone home phone
HomeCellular mobile
HomeStreetAddr home address
Notes comment

• In some cases, more than one attribute maps to the
same field. If a server returns results with attributes
that map to the same field in the contact entry, Outlook
uses the attribute listed first above. Not all fields in
Contact Manager have corresponding ClickMail/LDAP
attributes.

Client programs
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QuickMail Pro

• Supports user login as common name only. ClickMail
compares the password (userPassword) of the first
entry found that has a matching common name.

• In addition to simple search, a powerful query-builder
with direct access to the query formula is included.

• The current versions of ClickMail and QuickMail Pro
have been reported to freeze on some Macs if
QuickMail is running on the same Mac as ClickMail
and does an LDAP lookup. There is no problem when
run on a different Mac than ClickMail.

Setup

1. From the Tools Menu, choose Directory Services. A small
dialog appears. From the pop-up menu, choose LDAP
Plug-in. Click Configure.

2. A list of services appears. Click Add.

3. In the Directory Information window, in Profile Name,
enter a name for your directory.

4. In LDAP Server Address, enter the address of the Mac
running ClickMail.

Examples: ldap.mydomain.com 123.45.67.89

6. Leave the other fields as they are. Click OK, then click
Done.

Search—Address Message

1. In the QuickMail Pro window, click the New button. In the
select form dialog, click OK. A message window appears.

2. From the Message menu, choose Address…. In the address
window, click Find.

Client programs
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3. The search window opens. Make sure the LDAP Directory
Profile is your ClickMail directory. In Search For, enter
the full or partial name to search for.

4. Click Search. Entries appear in the Search Results list.
Click a name to see details.

5. Check a box next to one of the names, and click Add. That
person’s name is now in the To field. Click OK.

Search—Add to Address Book

1. From the Configure menu, choose Address Books….

2. Select an address book from the list and click Edit….

3. In the address book window, click Find. The search
window opens.

Client programs

QuickMail Pro search dialog.
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4. Make sure the LDAP Directory Profile is your ClickMail
directory. In Search For, enter the full or partial name to
search for.

• Or, click Advanced for a more complex search. Enter
values for one or more attributes. When you click OK, a
standard LDAP search query is placed in the Search
For field.

5. Click Search. Entries appear in the Search Results list.
Click a name to see details.

6. Check a box next to one or more names. Click Add. Those
entries are placed in the Address Book. Click OK.

• To check all names at once, option-click any box
(Mac only).

Sherlock 2 and Network Browser

Mac OS 9 includes two LDAP-aware clients: Sherlock 2’s
People channel and the Network Browser. For complete
information on using these clients with ClickMail, visit our
special guide on the Gracion Software web site (http://
www.gracion.com/server/sherlock/).

Client programs
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Export/Import

ClickMail can import and export LDIF and tab-delimited text
files, and import from vCards. LDIF and vCard files contain
attribute names and data on multiple-line records. Tab-
delimited files are imported and exported by specifying a list
of fields in ClickMail. For most purposes, the built-in
standard list of attributes works well.

To import a file, either choose the appropriate format under
Import in the File menu, or drag and drop the file(s) on
ClickMail’s icon in the Finder.

• Entries are indexed as they are imported. This requires
short delays which may appear to freeze the Macintosh.
Other applications are momentarily suspended. A
status window shows when this is in progress.

Character set encoding

Tab-delimited and LDIF text files are presumed to be encoded
in Mac OS Roman, the normal character set used on
Macintosh. Files to or from Windows systems encoded in
Latin-1 (ISO-8859-1) may be translated with software such as
MacLinkPlus. Translation is not needed unless accented
characters are present in the file. Mac OS Roman, Latin-1,
and UTF-8 all have the same encoding for “regular” (US
ASCII, or 7-bit) characters.

vCards are presumed to use Latin-1 (ISO-8859-1) encoding.

Tab-delimited format

Multiple values in one attribute are delimited by vertical tab
characters, to allow manipulation in FileMaker.

Minimum fields: If your tab-delimited data contains at least
these minimum fields, you can import directly into ClickMail
Central Directory. ClickMail creates other necessary fields
(for example, a missing distinguished name attribute is
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created from any name information in the imported entry,
with the naming context from the DSE added). If common
name or first and last name fields are missing, these are
created as well.

Minimum field requirements

• Full name (common name) or first name and last name
(2 fields)

• Email address

Standard fields. A list of commonly used fields can be used
to create a repeatable tab field order. To set the field list, from
the Lists menu choose Standard Fields.

LDIF

LDIF (LDAP Data Interchange Format) is the standard text
format for LDAP servers. This format consists of attribute
names and values, one value per line, with a blank line
separating entries. An advantage of this format over tab-
delimited is that there is no need to map attribute names
with a separate list; the names are right there in each entry.
ClickMail can import and export this format.

vCard

vCard is a popular format for “electronic business cards.” One
vCard file contains one entry. Clickmail translates vCard
data labels into their LDAP equivalents, which are included
in our standard emailPerson entry type. A vCard can create
one new attribute type: if it includes a name prefix (“Dr.”,
“Mr.”, etc.), it is imported with the attribute name
“salutation.” ClickMail can import this format.

Import/Data Utility

A FileMaker “Import/Data Utility” template is included to
assist you in preparing and maintaining your entries. If you
have FileMaker Pro 3.0 or later, you can import data into the
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template, manipulate it, and export it in a format that can be
directly imported into your LDAP directory.

• You can often import tab-delimited data directly from
other sources into ClickMail, even without
distinguished names. See “minimum fields” above.

Importing from other sources with the Import/Data Utility
template

Click the Import button to import tab-delimited, comma-
delimited, SYLK, DIF, WKS, BASIC, Merge, Edition File,
DAM, ClarisWorks, or DBF format files. The fields are named
for the common attributes, with 4 “other” fields at the end for
other attributes. (Note: Do not import into fields named
“Global…”)

Manipulate your imported data as desired in FileMaker.
Scripts are provided to auto-create distinguished names,
common names, first and last names. (ClickMail can auto-
create these as well, but in the template you can select groups
of entries to work on.)

For multiple values in an attribute, put each value on a
separate line.

Export/Import
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Scrolling fields are provided for entry type (objectClass) and
common name (cn), but any field may use multiple lines.
Note: Multiple values are not legal for some fields under
LDAP standards.

For data manipulation we haven’t anticipated, use
FileMaker’s many functions. Get to know the Replace
function, a versatile tool.

When the data is ready for ClickMail, use the Export button
to export the data to a tab-delimited file. The default field
order here is the same as ClickMail’s “Standard” field order
(see Lists menu), but you can override the order if needed.

Note: If you are importing tree-structured entries into the
ClickMail directory, a child entry can only be imported if its
parent entry exists or was imported earlier. A parent’s
distinguished name is that of the child’s after deleting the
first attribute. Consider the order in FileMaker before you
export.

In ClickMail C.D., choose Import—Tab-delimited… and select
your file. Use the standard order or whatever order you
exported with in FileMaker. If any imported entry has the
same distinguished name as an existing entry, the existing
entry is replaced.

Check your new entries by choosing Entries… from the
Database Menu.

Importing with Drag-and-drop or AppleScript

Tab-delimited, LDIF, or vCard files may be imported by
dragging them to the ClickMail application icon in the Finder.
With drag-and-drop, ClickMail recognizes the format
automatically.

An AppleScript can import files into ClickMail, using the
command “open” followed by an AppleScript file reference. A
simple AppleScript example file is in the ClickMail folder.
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This version of ClickMail supports only open, run, and quit
AppleScript commands.

When a tab-delimited file is imported via drag-and-drop or
AppleScript, ClickMail looks in the folder containing that file
for a file called “ClickMail Field List”. If a ClickMail Field
List is found, ClickMail uses it to define the field order when
importing. If a List is not found, ClickMail uses the last field
list that was used to import.

Modifying your directory data offline

To make multiple or global changes that would be time-
consuming in the Entry window, you may export your entries
from ClickMail, modify them offline, then import them back
into ClickMail. You may export in LDIF format and edit in a
text editor, or use Tab-delimited format to bring the data into
FileMaker and work with it there.

When re-importing tab-delimited data, be sure the field list
shown when you choose Import… matches the tab-
delimited file.

• If you do not include all attributes in your directory’s
entries when you export and import, you may delete
attributes from existing entries in your directory when
you reimport them. To eliminate this possibility, You
can use the “Current” setting when you export, which
ensures that all existing attributes are exported (Lists
menu—Current Database Attributes). However, to
bring this file into the FileMaker template, you must
drag the fields into proper order when you import.

Here’s the step-by-step procedure:

1. From the File menu, choose Export—Tab-delimited….
This exports all records (except the DSE). Unless you have
non-people records (such as “ou” department records), use
the default setting of “Export People Only”. Use the
Standard attribute list (Lists menu) unless you have other
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attributes not on the list (in that case, try the
“Current” list).

• Here’s another way to see all attributes in use: From
the Database menu choose Attributes….

2. Open the Import/Data Utility in FileMaker. Click the
Import button.

3. The default field list matches the “Standard” list in
ClickMail. Make changes by dragging if you used Current
or your own list. (Note that the little arrows must be on for
each field you want to import.) When the list is correct,
click “Import”.

4. Modify your data as desired in FileMaker. Scripts are
provided to auto-create distinguished names, common
names, first names and last names.

• If you will be reimporting back into the same datafile,
you may delete entries which you are not changing
(such as the subschema entry, “emailPerson”).

5. Export to a new tab-delimited file. If you used a special
field order when you imported, choose Export Records
from the File menu to export in the same order (check the
pop-up menu for “Last Order”). If you are using the
standard order, click the Export button instead.

6. In ClickMail, you may either import into the current
datafile or start a new file. (For example, a new file would
be needed if you changed some distinguished names). To
start a new file, from the File menu choose Configure…,
click New, name the file, click Save, enter any other
settings, then click OK.

7. In ClickMail, from the File menu choose Import—Tab-
delimited…. The last-used field order is displayed (even if
you are working in a new datafile). Choose the appropriate
field order and import your data.
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• If reimporting into the original datafile, each imported
entry replaces its matching existing entry. ClickMail
identifies matching entries by comparing the
distinguished name.

8. Check your new entries by choosing Entries… from the
Database Menu.

Export/Import
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Permissions and security
• Warning: Only password-protected encryption gives

strong security to Internet services such as a directory
server. Encryption (such as SSL) is not currently
available with ClickMail. The protections below give
lesser, but still useful, security options.

Database permissions

Database permissions apply to the database as a whole, by
controlling whether a user can log in or search. Where a user
is denied by database permissions, that user cannot log in or
search.

To allow access by client programs, choose Permissions from
the Database menu. Set the permissions according to
directions for the Permissions Window, below.

• Warning: When permissions are enabled, anyone who
can connect via TCP/IP to the server running ClickMail
can read data from the directory via LDAP. This may
include everyone on the Internet. If you wish
information in the directory to be shown only to users
inside your company, use the IP Address range setting.
This does not guarantee that no one can possibly access
your data outside the company, but it provides some
security. You should have a working knowledge of
Internet security when setting up any Internet
protocol server.

The default for new directories is no access. That is, you must
set permissions for the directory before anyone can read
from it.

Attribute permissions

Each attribute may have its own permission setting, thus
restricting whether it is returned in client searches. When
first created, all attributes follow the Default Attributes
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Permissions, until and unless you specifically change the
permissions for that attribute. When created, the default
attributes permission is Read–Everyone.

• Exception: the “password” (LDAP term: userPassword)
attribute is created with a permission of no access.
Even though it cannot be read, it can still be used for
client log ins and compare operations.

Attributes window

To restrict access to
certain attributes,
choose Attributes from
the Database menu.
This opens the
Attributes window,
which lists all
attributes that exist
anywhere in the
directory.

To set permissions for a
specific attribute, select it in the list and click Perms…. This
opens a Permissions window for that attribute.

To set default permissions for all attributes, click the Default
button. This opens a Permissions window for default attribute
permissions.

• New attributes are added automatically when you edit
or import entries. A new attribute has the default
attribute permissions unless you set permissions for
that specific attribute.

Permissions window

This window is used to set access for one attribute or the
entire database. Currently, read-only access by client
programs is supported by ClickMail, so the Permissions
window contains settings for read access.

Permissions and security

Attributes window
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Types of Read Access

Everyone: Check this box to grant this permission (database,
attribute, or entry) to everyone, without requiring that they
log in with a password (“anonymous” access).

“whose IP is in the range:” To allow only users from within
a range of IP addresses, check this box. In the text field enter
a minimum and maximum IP number on one line separated
by a space and/or hyphen. You many enter as many ranges as
you wish. Attempts to access (the database, attribute, or
entry) from outside these IP addresses are not permitted.

Example: 123.45.67.1 - 123.45.67.100

Logged in Users: Check this box to grant this permission to
users who log in with a password (which matches their
password attribute value).

“whose IP is in the range:” To allow only logged-in users
from within a range of IP addresses, check this box. In the
text field enter a minimum and maximum IP number on one
line separated by a space and/or hyphen. You many enter as
many ranges as you wish. Attempts to log in with a password

Permissions and security

Permissions window, used here to limit access to the “home
phone” attribute
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(or once logged in, access the attribute or entry) from outside
these IP addresses are not permitted.

• Some client programs can log in with a name and
password . Currently, this is done “in the open” over
your network or the Internet (depending on where the
client and server are). This provides a very small
amount of security and control over who can view
restricted attributes. Encryption of passwords or data
is not available with this version of ClickMail.

• “Everyone” access includes logged in users. That is, a
user may log in with a password even if logged in
access is not enabled, if they meet the requirements for
“everyone” access (such as an IP address range).
“Everyone” means everyone. Logged in access settings
allow access by a user with the right password where
anonymous (everyone) access is not allowed.

LDAP Write Access

For LDAP clients that support updating entries (such as
maX.500), LDAP Write Access controls which clients may
make changes to LDAP entries. Only logged in users may
make changes. Like Read Access, Write permissions may be
limited by IP range.

User passwords

LDAP person entries may include a password attribute
(LDAP term: userPassword). The value(s) of the password
may be used to authenticate LDAP users, and users of other
services that use the LDAP Compare request. Permissions for
the password are turned off by default, so that it is not
returned in LDAP searches. The password is visible locally
when editing entries in ClickMail, and also in remote web
administration.

In AppleShare mirror mode, a mirror entry’s password, when
present, is synchronized with AppleShare user password. By
default, the password is only copied from AppleShare during
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synchronization if a password attribute already exists in the
mirror entry. To have all mirror entries add passwords from
AppleShare, under ClickMail Preferences check “Copy
passwords from ASIP Users & Groups.” If more than one
password value is present in the mirror entry’s attribute, only
the first value is synchronized with AppleShare. This makes
it possible to have an LDAP password that is different from
the AppleShare password.

Permissions and security
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Remote Web Administration

The XL version of ClickMail supports remote administration
using a web browser. This feature requires Netscape
Navigator 4.0. Remote administration may be run through a
regular or secure encrypted (SSL) web server. After a
password-protected login, the administrator may add, edit,
and delete entries, and change permissions for the directory
or attributes.

Installing Web Administration

Requirements:

• Server: Any Macintosh web server, including
AppleShare IP or Mac OS 8 Personal Web Sharing. A
web server with SSL encryption is recommended (such
as WebStar or Quid Pro Quo SSL versions).

• Client: Netscape Navigator 4.0 or later (including
Netscape Communicator), with JavaScript turned on.

Installation:

1. Locate the “cmweb” folder which was installed with
ClickMail. Place this folder in any folder served by your
web server. For example, the default shared folder for
Personal Web Sharing is “Web Pages” at the top level of
your hard disk.

• The next step depends on whether your web server
supports Finder aliases. Personal Web Sharing 1.5 and
AppleShare 6.x support them, PWS 1.1 and AppleShare
IP 5 do not.

2a. If your server supports aliases, make an alias of the
ClickMail C.D. application (Finder, File menu). Place the
alias in the web server folder, alongside the cmweb folder
(not in the cmweb folder). Rename the alias
“clickmail.acgi”—this tells the web server to treat it as a
program instead of a document. Enable aliases in your
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web server’s preferences
(Personal Web Sharing 1.5: open
the Web Sharing control panel,
then choose Preferences… from
the Edit menu).

2b. If your server does not support
aliases, place the ClickMail C.D. application in the web

Remote Web Administration

Personal Web Sharing and permissions

The Web Sharing control panel gives you two options for
setting web client permissions:

 Give everyone read-only access. Anyone can connect to
your Mac, browse the shared folder, and, if they have an
administrator password, use ClickMail Web
Administration. This option is simple and easy to use.

 Use File Sharing to control user access. Only folders that
have their Sharing set in the Finder can be accessed by
web browsers. You can require a password through the
Users & Groups control panel (also used for regular Mac
OS AppleShare file sharing).

• If you use an alias to the ClickMail application, you
must set sharing for the folder that contains
ClickMail, not just the alias.

For details on setting
up Personal Web
sharing, see the
document “Using
Personal Web
Sharing.html” in your
Web Pages folder.

Personal Web Sharing 1.1
shipped with Mac OS 8.0/
8.1. PWS 1.5, with
enhancements including
alias support, is available
from http://
swupdates.info.apple.com/

http://swupdates.info.apple.com/Apple_Support_Area/Apple_Software_Updates/US/Macintosh/Networking-Communications/Personal_Web_Sharing/
http://swupdates.info.apple.com/Apple_Support_Area/Apple_Software_Updates/US/Macintosh/Networking-Communications/Personal_Web_Sharing/
http://swupdates.info.apple.com/Apple_Support_Area/Apple_Software_Updates/US/Macintosh/Networking-Communications/Personal_Web_Sharing/
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server folder, alongside the cmweb folder. Rename the
application “clickmail.acgi”.

• The application or alias and the cmweb folder must be
at the same level of the same folder, as shown.

3. Set permissions for your web server so that you can access
both ClickMail and the cmweb folder via the web. Read-
only access is sufficient. Refer to your server’s
documentation for instructions (for Personal Web Sharing,
see box on previous page). You may set web server
permissions to require a password or allow guest (no-
password) access to the folders.

• If you password-protect your folders with your web
server, you’ll benefit from two levels of authentication:
(1) the web password to the folders, and (2) the
administrator password for ClickMail.

Configuring ClickMail for web administration

• Web administration login is password protected, and
limited to designated administrators. To have access,
you must become an administrator in ClickMail.

1. To enable web administration, choose Preferences… from
the Edit menu. Under Web Admin Access, check the On
checkbox. If desired, change the web session timeout. This
sets the time that ClickMail waits after the latest web
administration
command before
automatically
ending the
session. After the
session ends, the
administrator
must log in again
to do more work.
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2. In your own entry, add a password attribute with your
administrator password (choose “password” from the
attributes pop-up menu). Save your entry.

• Warning for AppleShare IP integration: When
ClickMail is run in AppleShare mirror mode, password
attribute values are also set in AppleShare. If you enter
a different password in ClickMail, you are changing
your AppleShare password! If you are the AppleShare
IP administrator, you need this password to access
local AppleShare IP Web & File Admin. ClickMail itself
must have an AppleShare IP Administrator password
to connect to AppleShare. Do not unknowingly change
or forget your administrator password.

If you want to use a different password for web
administration than your AppleShare password, enter
your AppleShare password in the password attribute,
then click Add Value. Enter your web administration
password as the second value. Either value can be used
for web administration logins, but only the first value
is stored in AppleShare.

In AppleShare mirror mode, the synchronization
function updates passwords only in ClickMail entries
that already contain a password attribute, unless the
“Copy passwords from ASIP Users & Groups”
preference is checked. Only the first password attribute
value is updated.

• Security note: Your password is not encrypted or
secure when you log in unless you run ClickMail under
SSL encryption provided by your web server and
browser.

3. From the Entries menu, hold down the option key and
choose Add Group…. This creates an “administrators”
group entry with the correct name and attribute values.
The distinguished name for this entry must be
“cn=administrators” followed by your naming context
(usually “c=US”).
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4. In the administrators entry, select the “member” attribute.
From the Entries menu, choose Paste DN…. Double-click
your name in the list that appears, which enters your
distinguished name as a member. Save the entry.

Using Web Administration

Logging in

1. Open your Netscape 4.x web browser and go to location
cmweb/index.html on your web server. For example, if
cmweb and clickmail.acgi are at the top level of your web
folder, you would enter URL “http://www.myserver.com/
cmweb/index.html”. You may use a numeric IP address
instead of the domain name (“http://123.45.67.89/cmweb/
index.html”).

• Bookmark this URL for future web sessions.

2. If web server has password protection set for the folder
containing cmweb and ClickMail, you will see the
standard web browser authentication dialog. Web folder

Remote Web Administration

Group entry “cn=administrators” specifies the web administrator(s).
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authentication is separate from and unrelated to
ClickMail Web Admin login and password, which is
handled in a web page form. If required, log into the
folder.

3. The ClickMail Web Administration heading and
information page appears. The information page contains
directions for web administration functions. To open the
information page in a separate window, click the heading
link “Web admin guide” such that you get the pop-up
menu (Macintosh: click and hold). Choose “New Window
with this Link” from the pop-up menu.

4. Click the heading link, “Administer directory.” This opens
the login page, a web form containing several text entry
fields and buttons.

Remote Web Administration

Web administration login page.
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5. The ClickMail Server field contains the URL to the
ClickMail program or alias. If you have installed as
described above, the default value, “../clickmail.acgi” is the
correct URL to open ClickMail.

6. In Administrator’s Distinguished Name, enter the
distinguished name of your administrator entry, including
any naming context. This entry must be listed in the
member attribute of the administrators group entry
(created above).

7. In Password, enter the password for your administrator
entry. ClickMail compares this to the password attribute
in the entry under the distinguished name in step 6.

8. From the pop-up menu, choose the first action you would
like to take:

Find: Opens a find mode page for searching the
directory.
Entries: (Edit Mode) Opens an entry page, similar to
opening the Entries window in the local ClickMail
interface.
Browse: Enters browse mode, which lists all top
entries of the directory on one page.
Directory Permissions: Opens the permissions
settings page for the entire directory.
Attribute Permissions: Opens the attribute selection
page for setting attribute permissions.

• In this version, permissions may only be accessed from
the login page.

9. If your directory contains special characters in any
attribute (such as é, or £), you must tell ClickMail and
Netscape to use a special character encoding. From
Netscape’s View menu, Encoding submenu, choose
“Unicode (UTF-8)” and check the checkbox on the web
form for this encoding. Netscape must be operated with
UTF-8 encoding to avoid corrupting special characters
when entries are edited. If your database contains no
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special characters (all values are plain US ASCII), you
may operate in Netscape’s default encoding, called
“Western (ISO-8859-1)”.

• “Western” encoding does support the display of special
characters. However, special characters in web edit
fields are corrupted upon submission of an entry to the
server. Even if you are editing a different attribute, any
attribute that contains special characters in that entry
is corrupted when you submit the change. Viewing
under “Western” is okay only if you can completely
resist the temptation to change an entry (or if you have
no special characters in the entries).

To change encodings during a web session, return to
the login page, check or uncheck the box, choose the
encoding in Netscape, and log in again. Do not change
Netscape’s encoding unless you are on the login page.

When working in UTF-8, do not resize the window—
this may corrupt special character values in the
browser. If you see square root symbols (√) where your
special characters used to be, you are looking at
improperly decoded UTF-8. Click Cancel and start
editing the entry again.

UTF-8 mode may also cut off the bottom of pop-up
menus, especially the Attributes menu. As a
workaround, choose Other... and type in the attribute
name (one of ClickMail’s “English” names as shown in
the local entries window pop-up menu).

10. Click the login button. ClickMail validates your login and
displays the page requested by the pop-up menu.

• If ClickMail is not already running, the web server
launches it in response to the login request. ClickMail
keeps running until it is quit locally on the server.

• If you plan to run more than one web admin session at
a time, be aware that ClickMail does not lock entries
that web clients may be editing. Changes may be lost if
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two administrators work on the same entry at the same
time. Also, only one session per IP address is allowed.

Edit Mode

To view, edit, add, or delete entries, use edit mode. To enter
this mode, from the login pop-up menu choose Entries, or
from other pages’ mode pop-up menu choose Edit mode.

Edit mode corresponds the Entries window in ClickMail’s
local interface. As in the local window, each entry is “live:”
any changes made to an entry are stored simply by choosing a
command to view, find, or browse other entries. The Submit
button, which saves the current entry, does not have to be
used.

• Do not use the browser’s back button or command
while working in web administration. Going back does
not get you anywhere useful. If you have a problem or

Remote Web Administration
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get an error page, click the “Administer directory” link
in the heading and log in again.

Navigation controls for edit mode are at the top of the page.
Use the arrow buttons to go to other entries, just like the local
interface. To switch to Find Mode or Browse Mode, choose
from the mode pop-up menu. As in the local interface, any
changes to the current entry are saved when you go to
another entry or mode.

To add or remove an attribute value, click the plus or minus
icon next to a value. To add a new attribute, choose it from
the New Attribute pop-up menu. To add an attribute that is
not in the menu, choose Other… and enter the attribute name
in the Attribute column, alongside the new value.

The distinguished name (dn) of an entry uniquely identifies
that entry in the directory. The attribute value that makes up
the first part of the dn has a bold attribute name. The dn may
be changed by changing the value of that attribute. To use a
different attribute value as the first part of the dn, click the
“DN:” label (upper left of the page, next to the distinguished
name). This opens a separate window. Choose the attribute
and value you want to use for the distinguished name.

• How it works: Editing an entry is handled locally in the
browser (using JavaScript), so that the server does not
have to be accessed every time you click on something.
When you leave an entry that has been changed, it is
sent to the server.

To reset attribute values to their previous values, click the
Reset button—however, this does not undo the adding or
deleting of attributes. To cancel all changes made to the
current entry, click the Cancel button. The original entry is
displayed.

To delete the current entry, click the Delete entry button.
Entries with children may not be deleted unless you first
delete their children.
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To store changes to the current entry, click the Submit
button. Or, click one of the entry arrow buttons, the add entry
or add child buttons, or choose a different mode from the
mode pop-up menu. Changes are not saved if you close the
window, click a link in the heading, type in a new URL, use a
bookmark, or use the browser’s Back, Forward, or other
navigation commands.

To create a new entry, click the add button or add child
button at the top of the page. A blank entry based on
ClickMail preset emailPerson entry is created. Fill in or add
any attributes desired, then click Submit, an add button, an
arrow button, or choose a new mode. Any attributes with
blank values are stripped from the entry before it is saved.

• AppleShare mirror mode and entries: When the
directory is an AppleShare mirror, an extra item
appears at the bottom of the entry page. Existing
entries display an AppleShare user icon that is crossed
out or not depending on whether this is an AppleShare
mirror entry. To set a whether a new entry becomes an
AppleShare entry or not, check the “Is this an
AppleShare IP user or group?” checkbox (or not). This
must be done before the entry is first saved. Group
entries in AppleShare are not actually created by this
version of ClickMail.

Find Mode

To locate an entry or to list entries sharing a common name
or attribute, use Find mode. To enter Find mode, choose it
from the mode pop-up menu at the top right of all web
administration pages, or from the pop-up menu on the
login page.

Find mode displays a blank entry listing all attributes that
exist in the directory. Enter values into one or more
attributes. The values are treated as substrings. If you want
an exact value, type an equal sign in front of the value
(“=Smith”).
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If you enter values in several attributes, only entries that
contain all the values are returned (this is a boolean AND of
the values). Searches are not case sensitive. Accented letters
in entries are a match for their plain text equivalents you
enter in find mode (“e” finds “é,” “ê,” etc.).

When you have entered your search terms, click the Submit
button at the bottom of the page. ClickMail returns a list of
entries that match what you entered (this is different from

Remote Web Administration
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the local interface, which does not have a list mode). If no
entries are found, the search page is returned so you can try
again.

List Mode

A successful find returns a list of found entries. To view and
edit any entry, click the left arrow for that entry in the list. To
list the children of a found entry, click the down arrow for
that entry.

To return to Find mode or enter Browse mode, use the mode
pop-up menu at top right of the page.

When you go from a list to an entry (in Edit mode), a “List”
arrow button  is added to the entry page. To return to the
list, click the list arrow.

Browse Mode

Browse mode is a special list mode that allows browsing
through the entire directory in list form. To enter Browse
mode, choose it from the mode pop-up menu at the top right of
most web administration pages.

When you enter Browse mode, it lists all entries at the top of
the directory tree. If your directory is “flat,” this lists all
entries.

Remote Web Administration
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• Technically, the DSE is the real top entry. Browse
mode lists all direct children of the DSE. To view the
DSE itself, click the up arrow from the first browse
mode list.

To view and edit any entry, click the left arrow button for that
entry in the list. To list the children of a found entry, click the
down arrow button for that entry.

To view the parent of the current list, click the up arrow
button (top left of the web page). To list all entries in the next
level up in a branch, go up two levels then back down one. In
other words, do this to list the aunts and uncles as well as
the parent.

Permissions

Permissions mode is used to set directory and attribute
permissions, which control LDAP client access to the
directory and its data. To enter permissions mode, log in and
choose Directory permissions or Attribute permissions from
the login pop-up menu.

Remote Web Administration

Browse mode listing of a small directory.
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The permissions page for the directory and for each attribute
is the same as the permissions page in the local interface. To
make changes to permissions, enter them in the form and
click OK. ClickMail next displays the main Attribute
permissions page, where you can select a different attribute
or switch to Edit or Find mode.

For more information about permissions settings, see the
Permissions chapter.

Directory permissions

To change LDAP client permission settings for the database
as a whole, choose Directory permissions on the login page.
This directly opens the Directory permissions page.

Attribute permissions

To change LDAP client access for a single attribute, choose
Attribute permissions on the login page. This opens the
Attribute permissions page.

Remote Web Administration

Setting directory permissions via web administration.
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• Attribute permissions determine which attribute
values can be “seen” by LDAP client programs. This
allows you to keep certain attributes private from some
or all client users.

From the Attribute permissions page, choose an attribute
from the “Choose one” pop-up menu, which lists all attributes
in the directory. This opens the permissions settings page for
that attribute.

To set the default Attribute permissions, choose Attributes
Default from the “Choose one” pop-up menu. Default
permissions control the access to all attributes for which you
have not set individual permissions..

In the permissions form, make any changes desired and click
OK. When OK or Cancel is clicked, the Attribute permissions
page with the pop-up menus reappears.

To enter Edit mode or Find mode, or view Directory
permissions, choose from the mode pop-up menu at the top of
the Attribute permissions page.

Customization

The “Web Administration” banner in the heading area may be
replaced with a custom graphic, if desired. Use a GIF image,
400 pixels wide by 72 pixels high, resolution 72 DPI. Name
the file “your_logo.gif” and replace the file by that name in the
cmweb folder. To avoid web interface problems, do not replace
other files in that folder.

Remote Web Administration

Attribute permissions page. The “Choose one” pop-up lists all attributes.
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Reference
• Cross references given in this section are hyperlinked if

you are using the Acrobat or HTML versions. If this is
ink on paper, find cross-reference terms in the
Contents or Index.

Menus

File menu

Configure…: Configure settings for the datafile, including
New and Open commands. See Configure Directory Server
Window, below.

Import, Export: Submenus allow selection of two text
formats, LDIF (which can be edited in a text editor) and tab-
delimited, which can be manipulated in a spreadsheet or
database. A third format, vCard, may be imported. The vCard
format is an “electronic business card.” See Export/Import.

Logging…: Controls the display and storage of a log of events
that occur in the operation of the directory, particularly client
activity. See Logging Window, below..

Backup: Makes a backup copy of the directory, which
consists of a datafile and “<datafile name> keys” file.
Prepends “copy of “ before the names of the two files. Because
of this, your datafile name must be 18 characters or less. See
Making a new directory.

Reindex: Deletes all attribute indexes and recreates them.
Normally done only when upgrading from an old datafile
format (ClickMail reindexes automatically when needed).
Reindexing takes several minutes or longer, depending on the
size of your directory.

Compact Datafile: Removes unused space that accumulates
in the datafile. This can be done at any time, but ClickMail
prompts you at quit time if it thinks a compact is needed.

Reference
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Resync from AppleShare: Synchronizes all mirror entries
with the current items in AppleShare Users & Groups. For
AppleShare mirror mode only.

Attributes Reference: Opens a simple reference window
listing common attributes and their LDAP names.

Edit menu

Serial Number…: Enter the serial number to activate your
purchased copy of ClickMail.

Preferences…: Choose preferences that stay with ClickMail,
as opposed to settings associated with datafiles. See
ClickMail Preferences Window, below.

Database menu

Permissions…: Sets overall access to the server by clients.
See Database permissions.

Attributes…: Sets permissions for attributes in general and
individually. See Attribute permissions.

Entries…: Opens Entry window for viewing and editing
entries in the current directory. See Working with entries.

Windows menu

• A utility menu for finding, arranging, and hiding open
windows.

Lists menu

This menu is used only with the Import and Export Tab-
delimited windows. It helps you save and use lists of
attributes/fields for importing and exporting external files.

Reference
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Open Field List…: Opens a text file containing a list of
fields and loads them into the attribute/field list in the
Import/Export window. This replaces the current list.

Save Field List…: Saves the list of attributes/fields
currently showing in the Import or Export window as a plain
text file.

Standard Fields: Replaces the current attribute/field list
with a list of attributes commonly used for person records.
This option is good for exporting person entries that you plan
to reimport later. The FileMaker Import/Data Utility
template is preprogrammed with this list. This can be
undone.

Current Database Attributes: Replaces the current
attribute/field list with a list of all attributes that currently
exist anywhere in the directory. This option is good for
exporting person and non-person entries that you plan to
reimport later. ClickMail remembers the last list you used in
the Import or Export window. This can be undone.

Entries menu

To use this menu, open the Entries window (from the
Database menu).

Find DSE: Finds the “DSA-Specific Entry,” an entry required
by LDAP that is at the top of the directory tree.

Find Subschemas: Finds all subschema entries, which state
what attributes belong in an entry type. ClickMail creates one
subschema entry automatically.

Find Groups: Finds all group entries, which contain lists of
dn’s referring to other entries.

Add Group…: Creates a group entry. Hold down option to
create an administrators group for ClickMail remote (web)
administration.

Reference



80

Paste DN: Pastes one or more distinguished names into an
attribute. Select the attribute first.

Windows

• All major ClickMail windows contain a balloon help
button . For more information about items in a
window, click the button and point to the items. Click 
again to turn off the balloons.

Attributes window

Lists all current attributes—for setting permissions. See
Attributes Window, under Permissions and Security.

Attributes Reference window

This reference window lists common attributes by their plain
English meanings and their LDAP names.

Choose an AppleShare Server window

When a new AppleShare mirror datafile is opened, this
window allows you to choose from all AppleShare IP servers
available on the network. This could also appear if the
AppleShare server becomes unreachable.

Configure Directory Server window

This controls what datafile the server uses and global settings
for this directory.

Stand-alone server or AppleShare Users & Groups
mirror: Choose whether this directory runs on its own or
loads and updates itself from an AppleShare IP Registry. See
Mirroring AppleShare.

Administrator Name: The user name of an AppleShare
server administrator. Required to be able to access and mirror
AppleShare.
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Administrator Password: Password of an AppleShare
server administrator. Also required for access.

Email Domain: The domain name of email users on the
AppleShare server. Used to create full email addresses from
Alias names in AppleShare.

Last, First / Last First: To properly support users who have
AppleShare user names in surname-before-given name
format, check either or both boxes. Use “Last, First” if some of
these AppleShare user names contain commas; use “Last
First” if some do not.

Administrator’s Email: Enter the email address of the
administrator here. Will be used in a future version for
remote notification.

Reference
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Max entries to return: Limits the number of entries
returned to an LDAP client when a search is too broad. 100 is
a traditional value, although you may leave blank to allow
any number of entries to be returned. Some client programs
set their own limit, which is honored by ClickMail upon that
program’s request.

Max seconds to search: Similar to max entries, limits the
amount of time used by a single search, including the time to
return entries. Some client programs set their own time limit.

New… button: To create an empty, new datafile to store your
directory in, click New…. The datafile is actually created
when you click OK in the Configure Directory Server window.

Open… button: To open an existing datafile, click Open…
and select the file. The new file is actually opened when you
click OK in the Configure Directory Server window. Any
previously open file is closed at that time.

Entry window (titled by name of datafile)—see Working with
entries

Export/Import Tab-delimited window

This window, opened by the Export Tab-Delimited or Import
Tab-delimited commands in the File menu, lets you select
attributes to be exported/imported. By editing a plain text
list, you can select attributes by name and set the field order
for the tab-delimited file.

The scrolling text area contains a list of attribute names, one
attribute per line. The order of the names sets the order that
the fields in the tab-delimited file that will be created or
imported. When importing, fields may be ignored by inserting
blank lines in the list. To add, remove or reorder the names,
use cut and paste.

Names in the list are in “plain English,” as shown in the
Attributes Reference window. In cases where ClickMail does
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not recognize the
name, the actual
name entered is used
as the LDAP attribute
name.

When opened, the list
is set to what existed
when the Export or
Import button was
last clicked.
Optionally, commands
in the Lists menu may
be used to open and
save lists themselves
as text files, or paste a
standard list, or paste
a list of all attributes
currently in the
directory.

A checkbox, “Import Persons Only” or “Export Persons Only,”
filters the entries being imported/exported according their
entry type (objectClass). When checked, only entries with
entry type person (or emailPerson, organizationalPerson,
inetOrgPerson, residentialPerson) are imported/exported.
When exporting, entries with other types are not exported.
When importing, entries with other types are ignored
(and logged).

• On import, an entry without an entry type is assumed
to be an emailPerson.

Logging window

This window controls how events such as client searches and
file imports are logged.

The logging intensity pop-up menu controls the amount of
detail logged. The choices are None (no logging), Critical (only

Import Tab-delimited window with
standard field list.

Reference



84

errors and a few
essentials),
Important
(routine logging),
and All (extensive
detail for
troubleshooting).
The recommended
intensity is
Important.

Three logging modes are available: “Don’t log events,” “Log
events in window only,” or “Log events in window and to file.”
When this last option is enabled, a file named Log File, in the
same folder ClickMail, receives all log entries shown in the
window.

Permissions window - see Permissions Window in Permissions
and security chapter

ClickMail Preferences window

Three preferences deal with compacting, the function which
removes unused space from the datafile. Because this
function can interrupt other applications on the server, the
administrator can decide how and when this may be
performed. ClickMail checks for excess unused space after a
file import and when it quits.

Ask before compacting: When ClickMail finds significant
unused space exists in the datafile, this preference causes it
to put up a Cancel/OK dialog box before it compacts the
datafile. The administrator thus has a chance to cancel,
postponing the compact function until later.
(Default: checked).

Auto-compact if user does not answer: When this Cancel/
OK dialog is presented, and neither choice is clicked within 20
seconds, this preference determines whether ClickMail will
compact or not. If it is critical that compacting never

Reference
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interrupt other services without the administrator’s consent,
uncheck this preference. If it is more important that unused
disk space be reduced, check this box. (Default: checked).

• When more than 200 entries are imported at once,
ClickMail compacts the datafile every 200 entries. This
compacting cannot be turned off.

Backup daily: When checked, ClickMail creates a closed
backup copy of the current datafile, including the keys file.
Set the hours and minutes to time that will interfere least
with your users. A good time is shortly before your scheduled
network backup.

Sync to AppleShare daily: When checked, ClickMail
performs the Resync from AppleShare command each day at
the time entered in
the hours and
minutes fields.
This ensures that
user changes made
directly in
AppleShare Users
& Groups are
propagated to
ClickMail’s mirror
directory.

Compact daily:
When checked,
ClickMail performs
the Compact
Datafile command
each day at the
time entered in the
hours and minutes
fields. Although
the datafile is
compacted anyway
when ClickMail

Reference
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deems it necessary, this preference ensures that the datafile
stays as small as possible each day.

Administrator DN: When an entry is created or modified,
ClickMail “timestamps” the entry with the date and time, and
distinguished name of the person (such as a logged in web
administrator) who made the change. When entries are
imported or entered with the local ClickMail interface, the dn
in this preference field is used for the timestamp (default:
“cn=Directory Manager, c=US”). Please make sure this is a
valid distinguished name.

Default LDAP Client Character Set: Most LDAP clients
do not agree on a standard character set or encoding.
ClickMail examines the input from clients and does its best to
determine what encoding is being used. If your users use
mostly one brand of client, you can specify ClickMail’s default
“when in doubt” character set to match it. Here are the
character sets currently in use, according to our tests of
Macintosh clients.

UTF-8 Netscape 4.0 (but uses Macintosh in the DN
to log in)

Latin-1 Outlook Express, Eudora Pro

Macintosh (Mac OS Roman): Mulberry(?), QuickMail
Pro 1.5.

(Where Macintosh encoding was found,
expect Latin-1 from any Windows versions of
the same client.)

• The character set preference affects LDAP clients only,
not web administration.

These preferences apply when ClickMail is configured in
AppleShare Mirror mode only:

Web (CGI) Character Set: In order to view and edit special
characters in entry data via ClickMail’s Web Administration,
a character set must be used that is compatible with the web
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Reference

server that our CGI calls are going through. Different web
servers convert  characters differently. Select the character
set that works with server. UTF-8 is believed to work with
AppleShare IP 5 and Personal Web Sharing. MacRoman is
believed to work with AppleShare IP 6.x and Quid Pro Quo.
Test your system to verify which character set works.

Add new entries to ASIP Users & Groups: When checked,
all entries imported from text files will be created as
AppleShare mirror entries and added to AppleShare Users &
Groups as File-sharing enabled users. Also, new entries
created in the Entry window will default to AppleShare
mirror entry. When unchecked, all entries imported from text
files will not be added to AppleShare, and new entries in the
Entry window will default to non-AppleShare.

• When creating an entry in the Entry window, you may
click the AppleShare user icon to determine whether
the entry is mirrored with AppleShare or not. This may
only be changed before the entry is first saved.

Copy passwords from ASIP Users & Groups: When
checked, passwords are always copied from AppleShare users
to ClickMail’s mirror entries during synchronization. When
not checked, passwords are only copied/updated if the
password attribute is already present in a mirror entry.
Leaving this off provides some additional security, but
turning it on is useful for maintaining passwords outside
AppleShare. Changing this setting takes effect on the next
synchronization.

These preferences apply to Web Administration Access:

On (checkbox): When checked, Web Administration is
allowed.

Web session timeout: This sets the time that ClickMail
waits after the latest web administration command before
automatically logging out the administrator. After the session
ends, the administrator must log in again to do more work.
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Troubleshooting

Error messages in client programs

• In case of client errors, check the ClickMail log for more
information.

Can’t open/find server, can’t connect to server, server not
responding

The client and ClickMail are not talking to each other. Can be
caused by improper settings in the client, improper TCP/IP
settings on the client or ClickMail Mac, or network failures.

To observe whether the client is reaching ClickMail, watch
the ClickMail log window for activity when the client is used.

Make sure the IP address or host name entered for ClickMail in
the client program’s settings is correct.

Make sure that TCP/IP settings on the client computer and
the ClickMail Mac are both correct, and that they are both
connected to the network.

Verify that the client computer can “see” the ClickMail Mac—
that the TCP/IP connection works. This is best done with a
TCP/IP “Ping” utility run on the client. If there is a web or
email server running on the ClickMail Mac, try accessing that
service from the client.

Denied access, insufficient access

The client has been blocked by ClickMail’s database
permissions. Or, the client is attempting to log in with a
password, and logged-in access is not enabled or the password
is wrong.

In ClickMail’s Database Permissions, check that the proper
read access is enabled. If an IP range is in use, verify that the
range includes the IP address of the client computer.

Troubleshooting
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Check if client settings are configured to log in (authenticate).
If so, make sure logged in access is enabled in Database
Permissions. If an IP range is enabled for logged in users,
make sure the IP range includes the IP address of the client
computer. Make sure the password entered in the client’s
settings match the password attribute value in that user’s
entry. Make sure the user name or distinguished name
entered in the client program is correct.

Base object outside naming context (included in LDAP error 32)

The client specified a base object (a distinguished name,
usually in its preferences) that did not match the directory’s
naming context, or the base object did not have the same
ending as the naming context. Change the client program
setting. For basic lookups, leave the base object blank.

DN not found (included in LDAP error 32)

The client specified a base object (requested a specific entry)
that is in the directory’s naming context, but no entry exists
with that distinguished name. The dn logged (and possibly
displayed by the client) is the closest ancestor that does exist.
So a smart client could try again with that dn.

Other problems in client programs

Entries that should be found are not found

Verify that the search text is entered properly according to
the client’s design (see Client Programs). Some clients require
an asterisk before the entered term to find that term
anywhere in an attribute value.

In Outlook, the advanced preference “simple search” may
prevent you from getting the results you expect. See
Outlook Express.

Try the same search using Find in the Entry window to see
whether the correct entries are found. If not, make sure the
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entries contain the data you expect. If the entries are correct
but still not found, follow the step below to recreate the
datafile.

If Find succeeds in the Entry window but the client find does
not, either the client is not asking the right thing or ClickMail
does not understand the request. To troubleshoot this,
temporarily set your logging importance to “All” with disk
logging on (see File menu). You may be able to get a sense of
the request from this log. Or, send Gracion Software Tech
Support part of the log for analysis.

If using Eudora Pro 4.0, upgrade to 4.0.1.

As a last resort, to rule out the possibility that the directory
index is corrupted, recreate the datafile: Export all entries,
create an new datafile, and reimport the entries. LDIF format
works well for this.

An expected attribute does not appear in returned entries

Make sure that preferences for this attribute (individual or
default) allow this client to read the attribute. See Attribute
Permissions.

Make sure that the attribute you are requesting with the
client is really the same as that contained in the directory
(“street” is different from “postal address”). Netscape, Eudora,
and Mulberry have options to display all the available
attributes with their names. It may help to look at the
Attributes Reference window in ClickMail (see File menu),
which lists common attributes, and the plain-English names
used by ClickMail.

Troubleshooting
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Error messages in ClickMail

The application “ClickMail C.D.” could not be opened because
“OTUtilityLib” (or similar) could not be found.

One of the extensions that ClickMail needs is not in the
Extensions folder, or the Mac is running with extensions off.
Move the missing extension to the Extensions folder and open
ClickMail again. The name in the error message may differ
from the filename of the missing extension. ClickMail always
needs OpenTptInternetLib. For Systems 7.5–7.6.1,
AppleScriptLib, InterfaceLib, MathLib, and ObjectSupportLib
must also be present. These are all part of your normal
Mac OS.

Errors in the Configure Directory Server window

If an error occurs while opening the datafile, the Configure
Directory Server window is (re)opened with the error
displayed in red at the top. This can be a disk error when
trying to locate or find the file, or a corrupted datafile. Make
sure there is a “keys” file in the same folder as the main
datafile, by the same name plus a space and “keys”.

• A backup copy of an open file cannot be reopened—
before making a backup copy, the file must be closed by
ClickMail or copied using ClickMail’s Backup
command.

Try using the Open button to find or reopen the file.

If the error is disk-related, try restoring a backup copy of the
datafile or running a disk utility program.

TCP errors in the log

Check the TCP/IP settings for the ClickMail Mac. Check the
connection to the network or Internet. Try quitting and
restarting ClickMail.

Troubleshooting
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Web Administration error messages

• Error messages on a white background are from
ClickMail; error messages on a gray background are
from the web server.

A CGI or internal server component could not complete the
requested action (and similar web server errors).

ClickMail cannot be launched, the URL or application name
is wrong, or there is a permissions problem. Check your
installation and configuration of your web server
and ClickMail.

Unexpected or internal error in ClickMail

Something happened that wasn’t anticipated in ClickMail’s
programming. Please report the message and what led up to
it. To recover, Click the Administer directory link and log
in again.

Login Failed (white background)

You tried to login with wrong name, admin is not setup, or
the password isn’t right. Follow suggestions on error page.

Web Session Expired

Too much time has passed since your last command to the
server (as set in its preferences). Log in again to continue.

Other Web Administration problems

Can’t set Unicode UTF-8 encoding in Netscape (Western still
checked after choosing UTF-8).

To recover, choose Mac OS Roman, then re-choose Unicode
(UTF-8).

Troubleshooting
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JavaScript error

Different versions of the ClickMail application and cmweb
folder files (particularly cm_lib.js) may be conflicting.
Reinstall the latest version of the application and cmweb
folder to their correct locations (see Installing Web
Administration).

Other issues

Performance (speed)

Logging: avoid the “All” logging intensity setting, which
displays a large amount of information for troubleshooting
use.

Foreground/background: Although it runs slightly faster
when in the front (foreground), ClickMail runs nicely in the
background when another application is in front. However,
some applications, when in the foreground, slow down
background applications (including ClickMail). Two
applications to avoid running in the foreground over
ClickMail are Vicom Internet Gateway and FileMaker Pro
(regular version). Because FileMaker’s own hosting
performance suffers in the background, running ClickMail on
the same server as FileMaker is not recommended.

Giving ClickMail higher CPU priority: To prevent other
applications running with ClickMail from taking so much
CPU time that ClickMail slows down, use Peek-a-Boo ($20,
shareware). Peek-a-Boo can assign a lower priority to the
offending application , or give ClickMail a higher priority.
http://www.clarkwoodsoftware.com/peekaboo/

Importing problems

Check the log window for details on why individual entries
were rejected or ignored. Make sure your imported data
contains either a distinguished name, full name (common

Troubleshooting
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name), or first and last name fields. See Export/Import for
more information.

Tab-delimited files: Check that there are no return characters
in your data, thus splitting one entry into two. When the
Import People Only box is checked, entries are rejected if
their entry type is not a person or subclass of person known to
ClickMail (emailPerson, organizationalPerson,
inetOrgPerson, residentialPerson). For example, the
subschema entry in an import file would be rejected—but in
most cases that’s good.

Unexpected quits and crashes

ClickMail is stable running on Macs that meet its system
requirements. If you are experiencing crashes, check for
conflicting (usually non-Apple) extensions on your system,
and consider doing a clean system reinstall. Check the
Gracion Software web site to see if a newer version of
ClickMail is available. Email support@gracion.com with a
problem description and Apple System Profile report for a
quick response.

Older versions of ClickMail could run out of memory after
thousands of searches and crash. The current versions (1.1.1
and later) avoid this problem.

Troubleshooting
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Links and thanks

Web sites

• Gracion Software—information and discussion of
ClickMail Central Directory and related issues: <http://
www.gracion.com/server/>

• Internet Mail Consortium—information on email and
directory standards, vCards, and much more! <http://
www.imc.org/>

• ITU Publications, where X.500 documents describing
the basis of LDAP object and attribute types may be
purchased. <http://www.itu.ch/publications/
index.html>

• LDAP roadmap/FAQ <http://www.kingsmountain.com/
ldapRoadmap.shtml>

• Netscape Directory Server FAQ <http://
www.iplanet.com/products/infrastructure/dir_security/
dir_srvr/faq.html>

• Netscape’s objectClasses for their LDAP server: <http://
home.netscape.com/eng/server/directory/3.0/agbeta2/
objclass.htm>

Colophon

This guide was outlined in ClarisWorks and produced with Adobe
PageMaker 6.5. PageMaker’s pagination, indexing, hyperlinking,
and export to Acrobat and HTML features made it the best choice for
producing this document in both paper and electronic forms.

Body typeface: New Century Schoolbook 10/12.5
Imageset (so to speak) on a 600 dpi Apple LaserWriter 12/640.
Created on a Power Macintosh G3/266.
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Glossary
Acrobat Electronic document format by Adobe. One of

the formats this guide is published in.
Acrobat documents may be read with Acrobat
Reader from Adobe Systems.

AppleShare IP Server software from Apple that includes a
file, web, FTP, and mail servers. Contains a
Users & Groups Registry of users that
ClickMail can access when run in AppleShare
mirror mode.

AppleShare A directory run in this mode contains entries
mirror mode that represent users in AppleShare IP’s Users

& Groups Registry. The directory entries for
these users are kept in sync with the Registry
user information, such that AppleShare users
can be looked up by client programs.

attribute Part of an entry. Consists of an attribute
name (such as “work phone”) and one or more
attribute values (such as “+1 800 555 5555”).
Attributes store all the information in an
entry. There are certain attribute names
recognized by client programs.

attribute name The label for one kind of data in an entry,
such as the last name. ClickMail displays
attribute names in plain English, while using
the actual LDAP name to talk to LDAP
clients. For some common names and LDAP
equivalents, choose Attributes Reference from
the File menu. ClickMail supports attribute
names up to 127 characters.

balloon help Onscreen help that describes objects pointed
to in a window. May be turned on in the Help
menu or by clicking a  icon.

child An entry that is “under” a parent entry. For
example, a parent entry that represents a
department of a company may have child
entries representing the employees in that
department. Parent-child relationships are
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described by distinguished names. A child’s
distinguished name is created by adding
something on the front of the parent’s.

client “User” software that uses the services of a
separate “server” program to do something,
such as look up email addresses. Although
email programs are mentioned as clients
throughout this guide, other LDAP-aware
software can also act as a client to ClickMail.

common name An attribute. The common name contains the
full name of the entry (such as “Susan B.
Anthony”). Often used as the first part of a
distinguished name. Often contains several
values: with and without the middle name,
with a nickname as the first name, etc.

distinguished A special attribute that uniquely identifies an
name (dn)  entry. Used as a label to “distinguish” it from

any other entry. Made up of a list of attribute
names and values. Example: “cn=John Smith,
o=General Dynamics, c=US”

DNS Domain Name Service/Server. Internet
system that translates domain names
(“gracion.com”) into numeric IP addresses
(“123.45.67.8”). If a host name is used to refer
to the ClickMail server, a DNS server must
be reachable by the client to look up
ClickMail’s IP address.

DSA Directory System Agent. The X.500 term for a
program like ClickMail, and what the “D” in
DSE stands for (an acronym within an
acronym).

DSE DSA-Specific Entry. This is the “top” entry in
an LDAP server. It describes certain
attributes of the directory. Its distinguished
name is “” (an empty string). Its three
required attributes are namingContexts
(usually one, which you just entered),
subschemaSubentry (a list of distinguished
names of subschema entries), and
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objectClass (always “*”). The DSE cannot
be deleted.

emailPerson An entry type (objectClass) created for
ClickMail. emailPerson entries contain the
attributes that are commonly displayed by
email client programs’ search functions.

entry Container of attributes that describes a
person or other entity. A directory consists of
entries that can be searched and returned to
client programs. (Database term: record).

entry type An attribute that classifies the entry.
Identifies this entry as a person, organiza-
tion, country, device, specific kind of person,
etc. (LDAP term: objectClass)

host name A name representing a computer under TCP/
IP. A host name either is a domain name or
ends in one (examples: ldap.mydomain.com,
mydomain.com). To connect to a directory
server, a client program must know either the
host name or the IP address of the
server’s computer.

Latin-1 (a.k.a. ISO-8859-1) A character set encoding
commonly used on web pages and Windows
PCs. Some LDAP clients also use this
encoding. Special characters (“é” “ü” “ñ”) in
Latin-1 have different numeric representa-
tions than Mac OS Roman encoding. Latin-1
is a superset of US ASCII.

LDAP Lightweight Directory Access Protocol. An
Internet standard for accessing a directory
(such as an address book) over TCP/IP. This
sets the rules for how ClickMail talks with
clients and how the data in the directory is
labeled and organized.

LDAP-aware Having the ability to look up information
using the LDAP protocol (which ClickMail
uses). Although the best known LDAP-aware
clients are email programs, other kinds of
programs can be written to be LDAP-aware.
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LDIF LDAP Data Interchange Format. A text
format for representing LDAP entries.
ClickMail can import and export in this
format. It is commonly used with large-
system LDAP servers.

logging The recording of events in ClickMail’s
operation that may be displayed in a window
or written to a file.

IP address a number that refers to a specific computer
on the Internet. Usually seen as four
numbers separated by periods, it’s actually a
32-bit integer (which is why none of the four
numbers ever exceeds 255). A host name
usually represents one IP address, but an IP
address can be referred to by several host
names. (“IP,” seen also in “TCP/IP,” stands
for Internet Protocol.)

Mac OS Roman The character set encoding commonly used on
Macintosh. A superset of US ASCII (which
see). Compare Latin-1.

mail server Program that stores and forwards Internet
mail, according to Internet protocols such as
IMAP, SMTP, or POP. Examples of mail
servers on Macintosh are AppleShare IP Mail
Server and Eudora Internet Mail Server
(EIMS). Also the computer that a mail server
program runs on.

mirror Information maintained identically to that in
another place, so that it can be accessed in
another way. See AppleShare mirror mode.

naming context The last part(s) of distinguished names
common to the entire directory. In a parent-
child tree, which theoretically extends outside
the directory, the naming context could be
thought of as the parent of the directory. The
country attribute is commonly used as the
naming context (“c=US”).

objectClass LDAP term for entry type.
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permissions Settings that restrict access to a folder, entry,
or attribute to only authorized users.

port A virtual “connector” in a computer under
TCP/IP. A port is used to select a particular
program running on a server. ClickMail uses
the standard port for LDAP servers, 389.

preferences Program settings that are remembered after
the program quits. ClickMail’s preferences
are stored in the System folder’s Preferences
folder, as “ClickMail LDAP Preferences.”

RFC Request for Comments. Documents that
define Internet standards and protocols,
among other things. See http://www.cis.ohio-
state.edu/hypertext/information/rfc.html or
any Internet index.

schema Rules stating what attributes may or must be
contained in an entry, according to an entry
type (objectClass). A schema entry lists all
the attributes belonging to a one entry type.

subschema A more complicated way of saying schema.
Actually, subschema suggests a schema that
is subordinate to some other schema. In any
case, the entry type for entries that describe
schemas is subschema (see schema).

tab-delimited A kind of text file where fields of data
(attributes) are separated by tab characters
and records (entries) are separated by return
characters. Any spreadsheet or database can
export in this format.

TCP/IP (Transmission Control Protocol/Internet
Protocol—also TCP) A standard for format-
ting and exchanging data between different
computers over various networks (AppleTalk
is another such standard). Every packet of
data sent over the Internet is formatted
according to TCP/IP. TCP/IP is the “lowest
common denominator” format that carries all
Internet protocols (such as LDAP, SMTP,
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POP, and HTTP). Brought to you by the
Department of Defense.

Unicode A 16-bit character encoding system that can
handle most of the world’s writing systems,
including Western, Asian, and Arabic.
Equivalent to Universal Character Set (UCS)
ISO-10646. See UTF-8.

Users & Groups A list of users on an AppleShare server with
Registry certain attributes, such as Name, Alias, and

Comment. Some of these attributes are
mirrored in entries in a ClickMail directory
when run in AppleShare mirror mode.

UTF-8 Unicode adapted into 8-bit bytes. The
standard character set encoding for LDAPv3,
and used by some LDAPv2 clients (notably
Netscape). A key advantage of UTF-8 is that
its regular US ASCII characters (A–Z, 0–9,
etc.) are identical to US ASCII, Mac OS
Roman, Latin-1, etc.).

vCard The electronic business card format for the
Internet. ClickMail can import vCards.
Netscape Communicator has an option for
automatically attaching your vCard to
outgoing email. See <http://www.imc.org/pdi>.

X.500 The international standard for telecommuni-
cations systems directories, (part of Open
Systems Interconnection or OSI). The LDAP
standards are derived from X.500, and refer
back to X.500 documents to define attributes
and entry types. Traditionally, LDAP servers
were gateways to X.500 directory servers.
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